
Title: TOS Protocol and Procedure: Plot Establishment Date: 1/29/2016

NEON Doc. #:  NEON.DOC.001025 Author: E. Azuaje Revision: E

TOS PROTOCOL AND PROCEDURE:
PLOT ESTABLISHMENT

PREPARED BY ORGANIZATION DATE

Elena Azuaje FSU 12/04/2014

Katie Jones FSU 03/28/2014

David Barnett FSU 10/08/2014

Courtney Meier FSU 03/28/2014

Rachel Krauss FSU 03/28/2014

Jalynda McKay FSU 11/28/2014

Sean Hauser FOPS 10/23/2015

APPROVALS ORGANIZATION APPROVAL DATE

Andrea Thorpe PROJ SCI 1/27/2016

Mike Stewart PSE 1/25/2016

RELEASED BY ORGANIZATION RELEASE DATE

Anne Balsley CM 1/29/2013

See configuration management system for approval history.

 2016 NEON Inc. All rights reserved.

The National Ecological Observatory Network is a project solely funded by the National Science Foundation and managed under cooperative agreement by NEON,
Inc. Any opinions, findings, and conclusions or recommendations expressed in this material are those of the author(s) and do not necessarily reflect the views of the

National Science Foundation.



Title: TOS Protocol and Procedure: Plot Establishment Date: 1/29/2016

NEON Doc. #:  NEON.DOC.001025 Author: E. Azuaje Revision: E

Change Record

REVISION DATE ECO # DESCRIPTION OF CHANGE

A 01/10/2014 ECO-01139 Draft release

B 03/28/2014 ECO-01663 Production release, template change, and other changes as
detailed in Appendix A

C 10/15/2014 ECO-02355 Migration to new protocol template

D 02/23/2015 ECO-02566

 GPS Receiver Setup edits; A-3.C and A-6
 Extraction of the Rangefinder section to

NEON.DOC.001717
 Shifting and Offsetting Point Locations; SOP B.6
 Information located in boxes has been embedded in

protocol text.
 Added NEON Criteria for Wet Locations to Appendix D
 Updated Appendix E: general workflow, tower

workflow, mammal workflow.
 Delineation steps where reformatted

E 1/29/2016 ECO-03061

 Replaced the word ‘TruePulse’ to rangefinder across
the document.

 Rewording in Section 1.1.
 Additional details added about RRQRR sequence to

section 3 in the Methods.
 A.8 added site specific plot information.
 Metadata collection was moved to B.4.
 F.2 Lost Plot Markers section added.
 G.1 Legend of figure was edited.
 SOP H Plot Monumentation and Appendix I were

added to clarify steps and safety concerns



Title: TOS Protocol and Procedure: Plot Establishment Date: 1/29/2016

NEON Doc. #:  NEON.DOC.001025 Author: E. Azuaje Revision: E

i

TABLE OF CONTENTS

1 OVERVIEW .................................................................................................................................1

1.1 Background ................................................................................................................................... 1

1.2 Scope.............................................................................................................................................2

1.2.1 NEON Science Requirements and Data Products ................................................................. 2

1.3 Acknowledgments.........................................................................................................................2

2 RELATED DOCUMENTS AND ACRONYMS .....................................................................................3

2.1 Applicable Documents ..................................................................................................................3

2.2 Reference Documents...................................................................................................................3

2.3 Acronyms ...................................................................................................................................... 5

2.4 Definitions..................................................................................................................................... 5

3 METHOD ....................................................................................................................................6

3.1 NLCD Vegetation Classification..................................................................................................... 7

4 SCHEDULE ..................................................................................................................................9

4.1 Frequency and Timing...................................................................................................................9

4.2 Criteria for Determining Establishment Dates..............................................................................9

4.3 Timing for Laboratory Processing and Analysis ............................................................................9

4.4 Sampling Timing Contingencies .................................................................................................... 9

5 SAFETY .....................................................................................................................................10

6 PERSONNEL AND EQUIPMENT...................................................................................................11

6.1 Equipment...................................................................................................................................11

6.2 Training Requirements................................................................................................................16

6.3 Specialized Skills..........................................................................................................................16

6.4 Estimated Time ...........................................................................................................................16

7 STANDARD OPERATING PROCEDURES FOR TOS PLOTS...............................................................17

7.1 Workflow of Plot Establishment Activities..................................................................................18

SOP A PREPARING FOR ESTABLISHMENT......................................................................................19

SOP B PLOT ACCEPTANCE ............................................................................................................27

SOP C PLOT DELINEATION AND MARKING....................................................................................38

SOP D COLLECT GPS COORDINATES..............................................................................................47



Title: TOS Protocol and Procedure: Plot Establishment Date: 1/29/2016

NEON Doc. #:  NEON.DOC.001025 Author: E. Azuaje Revision: E

ii

SOP E DATA ENTRY AND VERIFICATION .......................................................................................52

SOP F RE-VISITING GPS LOCATIONS .............................................................................................57

SOP G SAMPLE SHIPMENT ...........................................................................................................59

SOP H PLOT MONUMENTATION...................................................................................................60

8 REFERENCES .............................................................................................................................65

APPENDIX A LOG SHEETS ...........................................................................................................66

APPENDIX B GPS RECEIVER SETUP..............................................................................................76

APPENDIX C CRITERIA FOR PLOT ESTABLISHMENT IN WET LOCATIONS........................................79

APPENDIX D PLOT ESTABLISHMENT WORKFLOWS ......................................................................80

APPENDIX E NLCD VEGETATION CLASSIFICATION DESCRIPTION......................................................90

APPENDIX F PLOT DELINEATION LAYOUT .......................................................................................92

APPENDIX G SCHEMATIC OF COMPLETE GRID USED TO LABEL PLOT POINTS ................................94

APPENDIX H TROUBLESHOOTING ...............................................................................................95

APPENDIX I PLOT MONUMENT INSTALLATION JSA ........................................................................98



Title: TOS Protocol and Procedure: Plot Establishment Date: 1/29/2016

NEON Doc. #:  NEON.DOC.001025 Author: E. Azuaje Revision: E

iii

LIST OF TABLES AND FIGURES

Table 1. The NLCD land use and land cover classification system for use with remote sensing data. ........ 7
Table 2. Contingent decisions.......................................................................................................................9
Table 3. Equipment list – A crew of two technicians preparing for establishment of one plot .................11
Table 4. Equipment list – A crew of two technicians performing field establishment of one plot ............12
Table 5. Materials provided for use of FOPs and FSU. These folders are located in the designated drive;
the specific organization of these folders is not outlined in this table.......................................................19
Table 6. Points to be logged by FOPS (also see workflow for each plot type in Appendix D). ...................48

Figure 1. Generalized site-scale sampling schematic for the NEON Terrestrial Observation System (TOS)
....................................................................................................................................................................17

Figure 2. Pathfinder Office project .............................................................................................................24
Figure 3. Plot Delineation step 1 ................................................................................................................39
Figure 4. Plot Delineation step 2 ................................................................................................................40
Figure 5. Plot Delineation Step 3 ................................................................................................................41
Figure 6. Plot Delineation Step 4 ................................................................................................................41
Figure 7. Plot layout and marker positions for 40 m by 40m Distributed Base Plots.................................45
Figure 8. GeoXH 6000 set up for high accuracy data collection. ................................................................47
Figure 9. The Obstructions tool within the Trimble Mission Planning web-based software .....................54
Figure 10. Adding an obstruction observed in the field within the Trimble Mission Planning software. ..55
Figure 11. Removing prexxisting plot markers with a pry bar....................................................................60
Figure 12. Do not allow the monument assembly sections to become separated while striking .............61
Figure 13. Do not lift the post diver above the top of the rod during the striking motion as the worker
could injure their leg or hand .....................................................................................................................62
Figure 14. Use a sledgehammer to seat the cap and drive the rod to the desired position .....................63
Figure 15. GPS receiver Geo XH 6000.........................................................................................................76
Figure 16. Schematic of the point ID grid ...................................................................................................94
Figure 17. Alternative strategy when obstructions are in line of sight during plot delineation ................96
Figure 18. Hypotenuse option to verify plot delineation measurements; .................................................97



Title: TOS Protocol and Procedure: Plot Establishment Date: 1/29/2016

NEON Doc. #:  NEON.DOC.001025 Author: E. Azuaje Revision: E

 2016 NEON Inc. All rights reserved.

Page 1 of 99

1 OVERVIEW

1.1 Background

The National Ecological Observatory Network’s (NEON) goal is to improve understanding and forecasting
of ecological change at continental scales over decades (Schimel et al. 2011). The design co-locates
measurements of atmosphere, soil, water, select organisms and disease, and airborne observations.
Observing change by integrating measures of the drivers and ecological responses will contribute to
improved understanding of ecological cause and effect (Vitousek 1997, Keller et al. 2008, Luo et al.
2011). High-level requirements derived from the NEON goal and mission guide the architecture of the
design and infrastructure for the national Observatory (Schimel et al. 2011). The primary requirement-
driven constraint of the design is that it must assemble sufficient data collected at points and local
regions (400-km2) to enable extrapolation of these functional relationships to the scale of the continent
over the course of several decades. The requirements framework permeates the NEON design,
providing guidance for the design of observations and direct linkages back to the NEON mission.

A suite of measurements that cross temporal and spatial scales will describe the ecological status and
future trends NEON is designed to detect. Fixed-wing aircraft measure the landscape across NEON sites
with high-resolution remote sensing, and tower-based sensors capture temporally continuous fluxes
over smaller spatial extents. However, neither approach is sufficient for terrestrial biogeochemistry and
organismal observations. A complete census of these measures at each site is biologically and financially
impractical – microbes are ubiquitous and birds are mobile. Measurement of these types of ecological
responses at sensor-like temporal frequencies is impossible, and even frequent observations at local
scales would likely provide redundant information or, due to financial constraints, be limited in spatial
extent. Hence, terrestrial organisms and soil will be measured at discrete temporal and spatial units by
human observers carrying out field-based observations.

The diversity of biogeochemistry and organismal measurements presents a formidable challenge to the
integrated collection of data for the Observatory. Measurements include biodiversity, phenology,
biomass, stoichiometry, prevalence of disease, and genomics of soil and organisms with a range of life
histories and phylogenetic traits (Keller et al. 2008). Components of each will be targeted for
observation with a sample design (Thompson 2012). The design must collect data that capture spatial
variability, facilitate the integration of observations, allow inference to unsampled populations, and
contribute to ecological insight at large spatio-temporal scales. The Spatial Sampling Science Design
(RD[15]) describes the proposed strategy: guided by NEON principles and requirements, the terrestrial
sampling design provides a data collection framework that is statistically rigorous, operationally
efficient, flexible, and readily facilitates integration with other data to advance the understanding of the
drivers of and responses to ecological change.  This protocol describes how to implement this design by
creating plots on the ground at NEON sites where the observations that inform the Observatory will be
made.
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1.2 Scope

This document provides a change-controlled version of Observatory protocols and procedures.
Documentation of content changes (i.e. changes in particular tasks or safety practices) will occur via this
change-controlled document, not through field manuals or training materials.

1.2.1 NEON Science Requirements and Data Products

This protocol fulfills Observatory science requirements that reside in NEON’s Dynamic Object-Oriented
Requirements System (DOORS). Copies of approved science requirements have been exported from
DOORS and are available in NEON’s document repository, or upon request.

Execution of this protocol procures samples and/or generates raw data satisfying NEON Observatory
scientific requirements. These data and samples are used to create NEON data products, and are
documented in the NEON Scientific Data Products Catalog (RD[03]).

1.3 Acknowledgments

This protocol relies heavily on advice and field experience provided by Dr. Benjamin Chemel with the
Northern Rockies Conservation Cooperative.
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2 RELATED DOCUMENTS AND ACRONYMS

2.1 Applicable Documents

Applicable documents contain higher-level information that is implemented in the current document.
Examples include designs, plans, or standards.

AD[01] NEON.DOC.004300 EHS Safety Policy and Program Manual
AD[02] NEON.DOC.004316 Operations Field Safety and Security Plan
AD[03] NEON.DOC.000724 Domain Chemical Hygiene Plan and Biosafety Manual
AD[04] NEON.DOC.001155 NEON Training Plan
AD[05] NEON.DOC.050005 Field Operations Job Instruction Training Plan
AD[06] NEON.DOC.014051 Field Audit Plan
AD[07] NEON.DOC.000824 NEON Data and Data Product Quality Assurance and Control Plan

2.2 Reference Documents

Reference documents contain information that supports or complements the current document.
Examples include related protocols, datasheets, or general-information references.

RD[01] NEON.DOC.000008 NEON Acronym List
RD[02] NEON.DOC.000243 NEON Glossary of Terms
RD[03] NEON.DOC.002652 NEON Level 1, Level 2 and Level 3 Data Products Catalog

RD[04] NEON.DOC.001271 NEON Protocol and Procedure: Manual Data Transcription
RD[05] NEON.DOC.014049 TOS Protocol and Procedure: Mosquito Sampling
RD[06] NEON.DOC.014045 TOS Protocol and Procedure: Tick and Tick-Borne Pathogen Sampling
RD[07] NEON.DOC.014040 TOS Protocol and Procedure: Plant Phenology
RD[08] NEON.DOC.000906 TOS Science Design for Terrestrial Biogeochemistry
RD[09] NEON.DOC.000907 TOS Science Design for Plant Phenology
RD[10] NEON.DOC.000908 TOS Science Design for Microbial Diversity
RD[11] NEON.DOC.000909 TOS Science Design for Ground Beetle Abundance and Diversity
RD[12] NEON.DOC.000910 TOS Science Design for Mosquito Abundance, Diversity and Phenology
RD[13] NEON.DOC.000911 TOS Science Design for Vectors and Pathogens
RD[14] NEON.DOC.000912 TOS Science Design for Plant Diversity
RD[15] NEON.DOC.000913 TOS Science Design for Spatial Sampling

RD[16] NEON.DOC.000914 TOS Science Design for Plant Biomass, Productivity, and Leaf Area
Index

RD[17] NEON.DOC.000915 TOS Science Design for Small Mammal Abundance and Diversity
RD[18] NEON.DOC.000916 TOS Science Design for Breeding Bird Abundance and Diversity
RD[19] NEON.DOC.001717 TOS Standard Operating Procedure: Rangefinder Use and Calibration
RD [20] NEON.DOC.002649 NEON Configured Site List
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2.3 Acronyms

Acronym Definition
HD Horizontal Distance
MDD Main Drop Down (menu icon in GPS receiver)
SDD Sub Drop Down (menu icon in GPS receiver)
NLCD National Land Cover Database
PPE Personal Protective Equipment
GPS Geographic Positioning System
RRQRR Reverse Randomized Quadrant-Recursive Raster
GLONASS Global Navigation Satellite System

2.4 Definitions

None given.
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3 METHOD

Plot establishment is an essential step in the development of the NEON Terrestrial Observation System
(TOS). Accurate and precise plot locations that represent the target ecosystem components at each site
will facilitate reproducible data collection and spatial analysis for the life of the Observatory. All plot
locations are created based on a spatially balanced random selection process (RRQRR), and individual
plots are then accepted or rejected based on an assessment by field technicians (RD[15]). The RRQRR
process results in a list of plots, each with a unique identifier called the Morton order. Following the
Morton order list in ascending order (smallest to largest) maintains the random selection process during
plot establishment. This document outlines the procedures for location, evaluation, establishment,
geospatial data collection and reporting for Tower Plots, Phenology Transects, Distributed Base Plots,
Mammal Grids, Bird Grids, Tick Plots and Mosquito Point locations.

Tower Plots are located within or around the NEON tower airshed and will be sampled for above and
belowground plant biomass and productivity, plant biodiversity, foliar and wood biogeochemistry, and
soil biogeochemistry. . Tower Plots will vary in size between and within sites depending on the dominant
vegetation type and sampling methods. Low biomass, low stature vegetation such as that found in
grasslands and homogeneous low diversity vegetation found in agricultural plots will be monitored in
400 m2 square plots, measuring 20 meters on a side. Forested sites require larger plots to accurately
measure plant biomass and productivity than sites dominated by herbaceous plants and shrubs. High
biomass vegetation, found in forest will be measured in 1600m2 square plots, 40 meters on a side. Plant
phenology transects are also located within the NEON primary 90% flux tower airshed. Within each site
there will be a subset of tower plots that require a hybrid approach because they contain additional
measurements of biogeochemistry and plant diversity, this subset will be specified and directed by FSU.

Distributed Plots will be located throughout the NEON site. Individual Distributed Plots may be accepted
or rejected based on a field assessment by field technicians; potential plot locations are only accepted if
the actual vegetation type is congruent with the assumed NLCD vegetation type. Prior to plot
establishment, each plot has been subjected to an initial vegetation assessment. All sentinel taxa
sampling will occur at Distributed Plots, although not all taxa will be measured at all Distributed Plots.

The Standard Operating Procedures in this document outlines the specifications for establishing each
taxa-specific sampling plot.  Site specific planning documents will identify the location of plots within the
site, specify which taxa will be sampled at each of the identified plot locations and provide lists of
contingency plot locations to replace rejected plots. This Standard Operating Procedure identifies plot
establishment required for all current TOS plot types. The initial establishment includes plot
acceptance, plot delineation, the collection of high resolution coordinates for each marker point, the
assignment of Unique Identifiers and the placement of permanent plot markers with corresponding
identifiers. Annual maintenance of established points may be necessary in the event markers are lost or
when markers are removed at the end of a sampling season due to site requirements. The annual



Title: TOS Protocol and Procedure: Plot Establishment Date: 1/29/2016

NEON Doc. #:  NEON.DOC.001025 Author: E. Azuaje Revision: E

 2016 NEON Inc. All rights reserved.

Page 7 of 99

marking of sampling points is achieved through the placement of temporary flagging or pin flags that
may be removed following the final round of sampling for the field season.

Several high resolution coordinates will be taken at several locations within each established plot. In
order to attain high accuracy (i.e. to within ≤ 30cm accuracy) at all points within each plot, a procedure
has been developed. This procedure includes a detailed field planning phase, and field techniques that
will assure the acquisition of the highest accuracy points given the tools available. The field planning will
require the use of software (Trimble Pathfinder Office and Trimble Mission Planning packages) and a
detailed GPS receiver accuracy setup. The field work will require attention to detail when following all
procedures and the use of best practices. The post-field protocol constitutes a download of the data
that will be post-processed by the Fundamental Sentinel Unit (FSU) or other Science staff at
headquarters (HQ).

3.1 NLCD Vegetation Classification

The NLCD is a continental scale land classification map. It spans the contiguous United States, as well as
Hawaii, Puerto Rico and Alaska. The classification scheme is a two-tiered hierarchy, and our assessment
focuses on the Level II categories (Table 1). The most commonly used vegetation types are in bold.

Table 1. The NLCD land use and land cover classification system for use with remote sensing data.

Level I Level II

1 Water 11 Open Water
12 Perennial Ice/Snow

2 Developed

21 Developed, Open Space
22 Developed, Low Intensity
23 Developed, Medium Intensity
24 Developed, High Intensity

3 Barren 31 Barren Land (Rock/Sand/Clay)

4 Forest
41 Deciduous Forest
42 Evergreen Forest
43 Mixed Forest

5 Shrubland 51 Dwarf Scrub*
52 Shrub/Scrub

7 Herbaceous

71 Grassland/Herbaceous
72 Sedge/Herbaceous*
73 Lichens*
74 Moss*

8 Planted/Cultivated 81 Pasture/Hay
82 Cultivated Crops

9 Wetlands 90 Woody Wetlands
95 Emergent Herbaceous Wetlands

*Alaska only
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Definitions of each land cover type are available in Anderson’s land use and land cover classification
systems (1976); also at http://www.mrlc.gov/.

Standard Operating Procedures (SOPs), in Section 7 of this document, provide detailed step-by-step
directions, contingency plans, sampling tips, and best practices for implementing this sampling
procedure. The value of NEON data hinges on consistent implementation of this protocol across all
NEON domains, for the life of the project. To properly collect and process samples, field technicians
must follow the protocol and associated SOPs. In the event that local conditions create uncertainty
about carrying out these steps, it is critical that technicians document the problem and enter it in
NEON’s problem tracking system. Use NEON’s problem reporting system to resolve any field issues
associated with implementing this protocol.

Quality assurance will be performed on data collected via these procedures according to the NEON Data
and Data Product Quality Assurance and Control Plan (AD[07]).

Quality assurance procedures for plot establishment will be conducted by NEON Domain Field
Operations staff and are an essential step in the establishment process.  Correct placement and
documentation of plot markers at each plot enable future field crews to locate and delineate plot
boundaries precisely and identify which type of sampling activities to conduct at each location.

If errors originating in field establishment are detected in a future review, they may be very expensive to
correct and will have a lasting effect on all sampling data associated with plot location. Field audits
should be performed early in the initial field establishment process, to ensure problems are detected
and corrected before an error is propagated across many plots. NEON will use a system of hot and cold
checks similar to that described by the USFS Forest Inventory Analysis (FIA) program. The basic
components of the FIA program are:

 Hot checks: Normally performed as part of the training procedure. Personal observation to
ensure accurate carrying out of protocol by field technicians.

 Cold checks: An inspection done either as part of the training process, or as part of an ongoing
QC program. Technicians are not present, and inspector does have access to field crew
generated data at time of inspection.
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4 SCHEDULE

4.1 Frequency and Timing

Except where placement of permanent plot markers is prohibited by site managers, initial plot
establishment and collection of high resolution geospatial data will occur once per site.

Annual establishment and re-marking of permanent plots for visibility may occur each year of operations
prior to seasonal field sampling.

Plot establishment must occur prior to scheduled taxa sampling.

4.2 Criteria for Determining Establishment Dates

Plot acceptance, delineation and marking should occur prior the start of first year of sampling.  Annual
plot establishment activities including re-marking of permanent plots should occur prior to seasonal
field sampling.

4.3 Timing for Laboratory Processing and Analysis

This protocol generates no samples for laboratory analysis.

4.4 Sampling Timing Contingencies

Plot establishment should be completed prior to Operational sampling. Interruptions or delays in the
process—either during a specific plot or all plots—do not impact NEON data products as long as plots
are in place to facilitate the accurate and repeatable observations of Operational sampling.

Reasons to delay sampling have to do with the optimization of establishing a precise, accurate plot with
good geographic record (GPS collection).  Reasons to alter the timing of sampling include:

 Precipitation (rain or snow) that interferes with rangefinder
 Dense canopy cover that reduces the satellite reception
 Periods of the day when satellites are less accessible
 Challenges with host site allowing the process to complete, i.e. access issues or other problems

with completing the process

Table 2. Contingent decisions

Delay/Situation Action Outcome for Data Products

Precipitation or
snow Stop rangefinding work No impact on data products as long as

plots are established prior to sampling

Insufficient satellite
reception

Spend more time at each point, optimize
time of day, or wait until leaf-off

No impact on data products as long as
plots are established prior to sampling
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5 SAFETY

This document identifies procedure-specific safety hazards and associated safety requirements. It does
not describe general safety practices or site-specific safety practices.

Personnel working at a NEON site must be compliant with safe field work practices as outlined in the
Operations Field Safety and Security Plan (AD[02]) and EHS Safety Policy and Program Manual (AD[01]).
Additional safety issues associated with this field procedure are outlined below.  The Field Operations
Manager and the Lead Field Technician have primary authority to stop work activities based on unsafe
field conditions; however, all employees have the responsibility and right to stop their work in unsafe
conditions.

A post driver and/or sledge hammer is used to drive the plot monuments into the ground. Safety
considerations for this equipment include:

 Inspecting and wearing appropriate personal protective equipment (PPE). This may include
impact gloves, hearing protection, and safety glasses.

 Maintaining appropriate posture while driving the monuments, including keeping the back
straight, having a stance square to the monument, and maintaining a safe working height (e.g.
working downhill of the monument and/or kneeling when appropriate).

 Using an appropriate driving technique to maintain control of the equipment, prevents missed
swings, and minimizes the potential for injury.

A hand or power saw is occasionally used to cut off a portion of the monument rod. Safety
considerations for this equipment include:

 Inspecting and wearing appropriate PPE. This may include cut-resistant gloves, hearing
protection, and safety glasses.

 Operating the equipment with a blade of the appropriate style and in good condition.
 Using an appropriate cutting technique to maintain control of the saw and minimizes the

potential for injury.
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6 PERSONNEL AND EQUIPMENT

6.1 Equipment

The following equipment is needed to implement the procedures in this document. Equipment lists are organized by task. They do not include
standard field and laboratory supplies such as charging stations, first aid kits, drying ovens, ultra-low refrigerators, etc.

Table 3. Equipment list – A crew of two technicians preparing for establishment of one plot

Item No. R/S Description Purpose

Q
ua

nt
ity

Sp
ec

ia
l

Ha
nd

lin
g

Durable items

MX102549 R GPS receiver, decimeter accuracy (e.g. GEO XH 6000, 7X) Loading data to GPS that will locate plots and
generate spatial locations of plot points 1 N

MX100322 R Laser Rangefinder Laying out the plot in proper dimension 1 N

R GPS Pathfinder Office Software NEON Loading data to GPS that will locate plots and
generate spatial locations of plot points 1 N

S Marker cutting equipment Cutting secondary markers 1 N

Consumable items

S Secondary markers (e.g. PVC pipe) Raw material for secondary markers

S Additional materials to label markers (e.g. spray paint) Label flags, PVC and/or other secondary markers 1 N
R/S=Required/Suggested
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Table 4. Equipment list – A crew of two technicians performing field establishment of one plot

Item No. R/S Description Purpose

Q
ua

nt
ity

Sp
ec

ia
l

Ha
nd

lin
g

Durable Items

MX102549 R GPS receiver, decimeter accuracy (GEO XH 6000, 7000) Locate plots and generate spatial locations
of plot points 1 N

R Extra battery for GPS receiver Extend field GPS collection time 1 N

MX105014 R Range Pole Bracket Secure range pole to GPS 1 N

MX105015 R Range pole with bi-pod attachment Hold antenna 1 N

MX105009 R Antenna Receive satellite information 1 N

MX105012 R Antenna Cable Connect antenna to GPS 1 N

MX100322 R Laser Rangefinder, ½ foot accuracy Lay out the plot in proper dimension 1 N

R Extra batteries for Laser Rangefinder Extend field time of rangefinder N

R Lens cleaning cloth Cleaning rangefinder lens 1 N

R Reflective tape or bicycle reflector Sight rangefinder 2 N

MX100320 R Compass with mirror and declination adjustment Sight angles for laying out the plot 2 N

MX100722 R Measuring tapes ≥30 m Measure distances for laying out the plot 2 N

MX104361 R Chaining pins or other suitable anchor Anchor measuring tapes 5 N
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Item No. R/S Description Purpose

Q
ua

nt
ity

Sp
ec

ia
l

Ha
nd

lin
g

R Maps Navigation to plot N

R Log Sheets Record information/notes 1 N

R Definitions of Land Use and Land Cover Classification Field-based validation 1 N

R Remotely-sensed plot assessment data sheets (Morton
Order Data Sheets) Reference 1 N

S GPS receiver, recreational accuracy with fully charged
batteries Navigation 1 N

R GPS Pathfinder Office Software Transfer and inspect spatial data 1 N

S Anchor Plot delineation 1 N

S PVC pipe cutter Cutting secondary markers 1 N

MX110476 R Survey Monument Post Driver (30 inches or longer) Install primary markers N

R Survey Monument Driving Pin Adapter Install primary markers N
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Item No. R/S Description Purpose

Q
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MX110497
(Medium)

MX110498
(Large)

MX110499
(Extra Large)

MX110500
(Small)

R

Impact gloves

Protect Hands from the potential force of
the driver striking the post.

1 pair per
staff N

MX104378 R Sledge hammer Driving monument rods 1 N

MX107089 R 4.5”x0.75” stainless steel driving adapter Driving monument rods 1 N

e.g.
MX101703 R Hand or power saw Removal of excess rod 1 N

e.g.
MX101535 R Pliers Tightening sections 1 N

MX109524 S Crow or pry bar Removal of temporary plot marker 1 N

Consumable Items

R Pin Flags, PVC posts or other temporary markers1 Used during plot delineation Max 20 per
plot N

R Secondary Markers (e.g. PVC, Survey stakes)1 Marking plot corners variable N

MX107388 R 2.5” flat survey cap, stamped Monument component variable N
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Item No. R/S Description Purpose
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MX106864 R 1’x0.75” aluminum monument rod sections Monument component variable N

MX106865 R 3’x0.75” aluminum monument rod sections Monument component variable N

MX106994 R 3’x0.75” aluminum monument rod sections Monument component variable N

MX106863 R 6”x0.75” aluminum driving rod section Monument component variable N

e.g.
MX101705 Metal blades for hand or power saw Removal of excess rod 1 N

R Paper plate Catchment for saw debris 1 N

S Additional materials to label markers (e.g. spray paint) Label flags, PVC and/or other secondary
markers 2 N

S Pencils Record information/notes 3 N

S Additional materials to label markers (e.g. spray paint) Label flags, PVC and/or other secondary
markers 1 N

R/S=Required/Suggested
1 Secondary and temporary marker quantities will vary depending on plot type and site-specific plot monumentation strategies, which will be dependent upon local conditions and
site host restrictions.
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6.2 Training Requirements

All technicians must complete required safety training as defined in the NEON Training Plan (AD[04]).
Additionally, technicians must complete protocol-specific training for safety and implementation of this
protocol as required in the Field Operations Job Instruction Training Plan (AD[05]).

All field technicians must have hands-on training with the GPS receiver with TerraSync software,
antennae, laser rangefinder and handheld compass with sighting mirror and declination prior to
conducting field work. At least two technicians in each domain shall be trained and proficient in the use
of GPS Pathfinder Office software and mission planning.

6.3 Specialized Skills

A team of two field technicians is required for plot establishment (delineation, marking and spatial data
collection). Training will be provided for all specialized skills required for carrying out plot establishment
(i.e. equipment use).  Technicians are not required to have any additional skills other than those
specified in the NEON Field Technician job description.  Proficiency with compass and GPS receiver is
useful and should be part of training to prepare to go into the field for this protocol.

6.4 Estimated Time

The time required to implement a protocol will vary greatly depending on a number of factors, such as
skill level, system diversity, environmental conditions, and distance between sample plots. The
timeframe provided below is an estimate based on completion of a task by a skilled two-person team
(i.e., not the time it takes at the beginning of the field season). Use this estimate as framework for
assessing progress. If a task is taking significantly longer than the estimated time, a problem ticket
should be submitted.

A two person team will require approximately four hours to establish one distributed base plot. Plot
establishment includes metadata collection, plot delineation, marking, and spatial data collection.
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7 STANDARD OPERATING PROCEDURES FOR TOS PLOTS

Figure 1. Generalized site-scale sampling schematic for the NEON Terrestrial Observation System (TOS)
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7.1 Workflow of Plot Establishment Activities
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SOP A Preparing for Establishment

Follow A.1-8 to complete preparation for plot establishment.

A.1 Resources

During training you will be provided with a NEON network drive path. This drive will serve as a
communication gateway between FSU and FOPS; it will also serve as a source of materials for data
collection. The corresponding drive will include the following materials:

Table 5. Materials provided for use of FOPs and FSU. These folders are located in the designated drive; the specific organization
of these folders is not outlined in this table.

Folder Content Format Purpose

GPS_Pathfinder_Files
Contains all GPS data files (plot
locations, roads, boundary and others)
used by FOPS for collection.

.imp
Data files to be used by
FOPS staff to collect plot
data.

Site_Information_&_Datasheets

Maps .pdf Maps to be used by FOPS.

Plot layout and site information .kmz Layers to be used in
google earth by FOPS

XX_XXXX_TOS_Plots_Datasheet:
Contains all Distributed plots, Morton
Order, vegetation type, plot status and
coordinates.

.xlsx

Datasheet to be used by
FSU and FOPS, must be
regularly updated by
FOPS.

Contains site information and notes
from previous remote and field (if
applicable) validation

.docx Background information
about the site for FOPs

Established
XX_XXXX_Unique_Identifiers:
Contains plot type, Morton Order and
PlotID.

.xlsx

This datasheet contains
all PlotIDs used to label
TOS plots. Datasheet
created by FSU and used
by FOPS.
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Folder Content Format Purpose

XX_XXXX_Validation_Information: .docx

Unique Identifiers should
be provided by FSU after
plots are established, to
be used for plot marker
labels.

Data_Dictionaries

Contains all data dictionaries. A Data
dictionary is a digital form used to log
metadata about each plot. Data
Dictionaries are uploaded to the GPS
receiver.

.ddf
To be used by FOPS to
collect ALL plot
establishment data.

Log_Sheets
Contains log sheets used to maintain a
record of markers and GPS data
collection.
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A.2 GPS Receiver Setup

The following are the general steps to follow in order to complete the GPS setup. To complete
this section please follow the detailed steps for the relevant GPS model and software version in
Appendix B.

1. Turn GPS receiver on.
2. Initialize GPS software (e.g. Terra Sync).
3. Once the GPS software is initiated, the first day of work at a site, make sure to adjust the GPS

time, specifically the GPS unit Time Zone, Date and Time.
4. Complete setup menu specifics.
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A.3 Global Navigation Satellite System (GNSS) Planning Online software

The GNSS Planning online software tool will help you understand satellite availability (number of
satellites) before heading out to the field. If the site at hand has little satellite cover (fewer than six
satellites at a time), it is important to find the windows of time with higher satellite availability. Use
these windows of time to collect high-accuracy data. If the site has a constant flow of six or more
satellites at a time, then the time of collection is less important. To find out satellite availability and to
plan your field days -as needed-, use the following steps:

1. Visit http://www.trimble.com/GNSSPlanningOnline/#/Settings
2. Click on the Setting tab located in the upper left side of the window.

a. To assess the relative satellite availability across a site, add the latitude and longitude of the
tower location (RD[20]).

To assess satellite availability of a particular plot location of concern, add the latitude and
longitude of the specific plot. You can find the plot location in the datasheets provided by
FSU. This may be useful if a technician knows of a potential satellite obstruction located
close to a plot (e.g. boulder) previous to field work.

b. Height : 0 m
c. Cutoff: change it to 0˚—however, this field can be changed if obstructions are known at a

particular plot. For this the latitude and longitude must be related to a particular plot.
d. Select the field Day
e. Select the starting time or Visible Interval and the time span in hours (generally a 6- or 12-

hour span).
f. Select the appropriate Time Zone.
g. Click Apply.

3. To the left of the screen click on the Satellite Library
a. Click on the GPS and the GLONASS satellite libraries; unclick the rest of the satellite libraries.

4. To the left of the screen click on the Number of Satellites.

This histogram will display the number of satellites (GPS and GLONASS) available on the Y axis, and time
on the x axis, including what the GPS would measure with any obstructions previously plugged in the
Settings (if any). The higher the number of satellites available the better the accuracy will be. This graph
will allow field workers to know when the best times to establish challenging plots may or may not be.

In your notes, record what times have the highest number of satellites (highest accuracy) and what
times have the lowest number of satellites (lower accuracy)  to collect GPS data. Avoid accruing data in
the times when there are fewer than four satellites available; otherwise the data will be of low accuracy.
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A.4 Transfer data to GPS

1. Connecting the GPS unit to the computer:

To complete this step, follow the directions in pages 30-33 in the Terra Sync “Getting Started
Guide” (Trimble, 30-33). This guide is available in the NEON network drive folder described in
SOP A.1.

2. Types of files to transfer for a typical fieldwork campaign:

The data files to transfer for a typical fieldwork campaign will be located in a shared folder
(Table 5 in folder ‘GPS_Pathfinder_Files’). These files will be in .imp format (these are Trimble
imported files that can be read by both Pathfinder Office and the GPS unit). There are three
types of files that will be transferred from Pathfinder Office to the GPS unit:

a. Background files include roads, lakes, streams, buildings, contours and others. These files
are located in folder GPS_Pathfinder_Files, see Table 5.

b. Data files includes points converted from ArcGIS shape files. These are the points that will
be followed and have been previously assessed for plot establishment. These files are
located in folder GPS_Pathfinder_Files, see Table 5.

c. GPS Data dictionary contains pre-defined attributes and metadata that can be associated
with newly logged GPS data. The GPS data dictionary will be completed for every point
collected. These files are located in folder Data_Dictionaries, see Table 5.
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A.5 Loading and checking files in GPS with Pathfinder Office

1. Open Pathfinder Office software
2. Create a project for each site. Set up the Default folders in the shared folders provided

Figure 2. Pathfinder Office project

3. Go to Options and select Coordinate System
a. Select by: click on Coordinate System and Zone select the appropriate system, zone and

datum
b. Altitude Measured From: select Mean Sea Level (MSL)
c. Coordinate units: Meters
d. Altitude Units: Meters
e. Click OK

4. In the main screen, select File > Background… and in the “Load Background Files” window, click
“Add…” and select the file(s) desired as background images (e.g. boundary, roads, streams).

5. Check the box next to the desired image(s).
6. Click OK to load the background files into the Map.
7. Click View > Map to visually check the images that will be loaded to the GPS.
8. To check datafiles open the imp, .ssf, .cor, or .imp file in pathfinder by selecting File>Open or

dragging the file into the map
9. In the main screen select Data>Feature Properties and select Data>Position Properties
10. Click on the X’s in the map view (the individual points) to load the point information in the

Feature Properties and Position Properties boxes.
a. For example, you can view the date, number of logs, estimated accuracy, and point feature

name of a point in an .ssf, .cor, .imp file.
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A.6 Transfer data files, GPS data dictionary, and background image(s) to the GPS unit

1. On the GPS, connect the GPS to the computer with the supplied USB cable, and power on the
unit. Tap on the Windows icon at the bottom left side of the GPS screen.

2. Find the TerraSync icon and tap twice with the stylus.
3. On the computer, use the Windows Mobile Device Center (Win7 or Vista) to connect the device

to Windows. If this is the first time connecting the GPS to the computer the Windows Mobile
Device Center may install automatically, if it doesn’t, download it online from the windows
software website.

4. Set the coordinate system in the Trimble TerraSync software to the corresponding coordinate
system used for the site:

a. In the TerraSync software on the GPS, from the MDD tap Setup then click the “Coordinate
System” box.

b. Match to the coordinate system of downloaded data, select: System = UTM, Zone =
appropriate zone, and Datum then click OK (RD [20]).

c. From the MDD, return to the Map screen.
5. Once the GPS unit is connected to the computer, within Pathfinder Office, use the Data

Transfer utility to transfer all the files (background, data dictionary and data files) to the
Trimble:

a. Go to Utilities > Data Transfer… and in the window that comes up, click the Send tab and
click Add… and select Background from the list. Select background files (e.g. boundary,
roads, streams and others) and click OK.

b. Then click Add and select Data Dictionary, browse for the appropriate GPS data dictionary
location in the shared drive, select all applicable data dictionaries and click Open.

c. Once more, click Add and select Data File, browse for the point files for all of the plot
locations, and click Open.

d. After selecting all file types to transfer to the GPS click Transfer All.
6. In the TerraSync software on the GPS, select the transferred image(s) as the background:

a. Use MDD and tap on Map. From this pane go to the Layers SDD and click Background Files…
b. In the list of files, select which image file(s) you would like to use as background and click

OK.
c. To temporarily turn off the background image (can be used to reduce software wait time

while making measurements) go to the Layers SDD and un-check Background.
7. When transfer is complete, disconnect the unit and follow model instructions.
8. Make sure the GPS is fully charged before heading to the field.

A.7 Configure the rangefinder

Refer to RD[19] for details.
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A.8 Site Specific Plot Information

An excel sheet will be provided for each site by science staff in a shared folder (Table 5 in folder
“Site_Information_&_Datasheet”). The sheet contains information regarding the morton order list, plot
type, plot size, plot location, number of target plots per NLCD vegetation type, and spaces for field
technicians to update progress. The sheet will be the main point of contact between FOPs and FSU
during plot establishment. PDF maps and kmz files for google earth will be provided as well.
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SOP B Plot Acceptance

AT THE START OF THE FIELD DAY, REMEMBER TO:

 Turn on the unit in an open area for at least 5 min before entering a closed canopy system.
 On a daily basis, verify that the GPS almanac has been updated within the last week or anytime

the unit is moved to a new NEON site. To update the almanac it is necessary to have at least one
satellite locked and it should take at most 15 minutes. To check when the almanac was last
updated go to MDD>Status and SDD>Receiver>Almanac

 Once the GPS has been turned on, take care to always keep the antenna relatively flat, even
when not collecting data. This will ensure that a minimum number of satellites are dropped.

 Do not stand in front of or otherwise block GPS unit. Make sure the barometric pressure holes
on the under-side of the Trimble are not obstructed.

 While hiking or collecting data, make sure the sleep function is disabled, every time the unit
goes into sleep mode satellites will be lost. To disable the sleep function:

o Press the green button for 3 seconds. This button is located below the screen
o Click on Power Settings
o Uncheck the box below On battery power
o Click OK

 Always take an extra fully charged GPS battery.
 Create a Waypoint for the location of the vehicle:

1. Click on MDD > Navigation
2. On the SDD > Waypoints
3. Click on New at the lower left side of the screen.
4. Location Default
5. Name waypoint at File Name
6. Click Done
7. Click on Options on the upper right, and then click on New.
8. Name the waypoint (i.e. RMNP_Car_06162011)
9. Click on Create Form on the upper right, and then click on GNSS. The coordinates should

load.
10. Click Done. Waypoint should be created.
11. To close the created file, go to Options and click on Close File.
12. Go back to MDD > Navigation. Make sure the SDD is on Waypoint and then Click OK. The

waypoint should be created.
13. When returning to the car, click on MDD > Navigation and SDD > Waypoints. Highlight the

file of interest and click Open on the lower right side of the screen.
14. Click on the box to active and tap for one second on the waypoint files. Click on Set Nav

Target
15. Go back to SDD> Navigate and when moving it will point you to the navigation target.



Title: TOS Protocol and Procedure: Plot Establishment Date: 1/29/2016

NEON Doc. #:  NEON.DOC.001025 Author: E. Azuaje Revision: E

 2016 NEON Inc. All rights reserved.

Page 28 of 99

B.1 Navigate to pre-loaded GPS point

Preloaded GPS points will be classified by plot type (See Method section for a list of plot types). Before
leaving the car create a waypoint of the car location or starting location AND write down the
coordinates and elevation of the car in a field notebook, this is a safety practice to ensure technicians
have coordinates to navigate back to the vehicle.

1. Open the data file associated with the current site:
a. Go to MDD > Data, and then go to the SDD > Existing File. You should see a list of data files

loaded onto the Trimble.
b. Select the data file associated with the current site, and click Open.

 Make sure that the Antenna Height is at 1 m, and the Type refers to the GPS internal
model . Keep the setting on “measure to bottom of receiver”; then click OK on “confirm
antenna height” pop-up.

c. Go to MDD > Map to see the plots loaded on the map. Go back to MDD > Data
d. Find the Plot Morton Order of the targeted plot. Tap and press (1-2 seconds) on the Morton

Order number. A pop-up menu should appear. Select Set Nav Target. Note: the targeted
plot should now have a flagged symbol.

Or

To set a plot as a navigation target from the MDD > Map, choose the Select tool (➚) from
the left-most SDD, and hold the stylus on the plot until a box pops up that says “Delete” and
“Set Target.” Choose “Set Target.”

To check the Morton order of a plot from the Map pane, tap on the select tool from the left-
most SDD menu. Tapping a plot icon quickly with the stylus will bring up the name and
coordinates of that particular plot.

2. To zoom in, while in the MDD>Map, go to the leftmost SDD menu and select the zoom-in tool.
Zoom in by dragging the stylus along a diagonal that encompasses the desired area.

3. Go to MDD > Navigation and make sure the left SDD says Navigate.

The Navigate window won’t make any sense until you are moving, as there is no internal
compass in the Trimble. Position needs to be calculated as changes in XY space are
calculated by the GPS receiver.

a. When close to the target position the location of the GPS is displayed as an “X” and the
target as an “O”. You will need to move around until you are as close as possible to the
desired location (“O”). Make sure you are at least 3 meters from the desired location. If you
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are having trouble obtaining the desired location within 3 meters, attach the antenna
following the instructions in SOP D.

b. When you have arrived at a targeted point, go to MDD > Map, and select Options > Clear
Nav Targets. Go to MDD > Data and click on Done and then on Close button to exit the
points data file. A window will pop up asking: Close this file.  Are you sure? Click on Yes.

If the unit goes into sleep mode, push the power button again to wake the unit and resume
data collection. Make sure to wait until satellites are re-acquired. A warning will pop up;
click Dismiss. If the GPS unit is not collecting satellites, go to MDD > Setup and click the GPS
button again to reconnect the GPS receiver. Then return to the Map screen and resume
data collection.

B.2 Canopy cover assessment

Canopy cover assessment will be based on the National Land Cover Database (NLCD) classification
(Appendix E) for all Distributed Plots. Plot locations are only accepted if the actual vegetation type is
congruent with the assumed NLCD vegetation type. The XX_XXXX_TOS_Plots_Datasheets provided by
FSU lists the NLCD land cover type in the “nlcdClass” column (see Table 5SOP A).

1. Once within the plot, determine location of plot perimeter, you can run a tape across four
cardinal directions (or use the range finder and reflector) and set up visual cues (it could be
flagging tape, a rock, a tree etc.) that would indicate the perimeter of the plot.

a. Since Bird and Mammal Grids are so large and it is difficult to determine land cover type
percentages err on the side of NLCD unless the classification is obviously off.

b. For Mosquito Points validate an area 40m by 40m with the point location as the centroid.
2. Determine plot Level 1 classification (e.g. Forest, Shrubland). Located in NLCD classification

description ( see Appendix E).
a. Remember- NLCD defines the dominant vegetation stratum by height (i.e. the tallest

vegetation is “dominant”) since NLCD assesses canopy from satellite imagery.
3. Within each Level 1 NLCD class, determine Level 2. For example, if the Level 1 classification is

Forest, the next step is to determine if it is a Deciduous, Evergreen, or Mixed Forest.

IMPORTANT: Level 1 classification determines the total percent cover for the plot (e.g. 40% of
the plot is forest); Level 2 is then assessed out of 100% of the Level 1 total (e.g. of the 40% of the
plots that is forest, 50% of that forest area is deciduous, 50% of that forest area is evergreen,
NOT 20% deciduous forest and 20% evergreen forest).

4. Evaluate the results of the Level 1 and Level 2 classification to determine whether the plot
should be accepted or rejected.

In instances where the plot classification (either Level 1 or Level 2) is unclear due to borderline
percent cover(s) (i.e. near the % cover cut-off described in E), acceptance or rejection should be
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based on group consensus. If disagreement persists, the plot should be rejected. For example,
when validating a deciduous forest plot (Level 2) where more than 75% of the total forest cover
in the plot should be deciduous to be accepted, if the sampling crew cannot agree because
person 1 thinks plot deciduous forest cover is below the 75% threshold and person 2 thinks the
plot is above this threshold, then the plot should be rejected.

If level 1 classification is rejected, please assess both Level 1 and Level 2 classifications and
record to the corresponding rejected plot metadata.

5. Begin metadata collection with the Trimble, regardless of the results of the above assessment,
as described in SOP sections B.3 through B.7.

a. If plot is accepted based on above assessment, place a temporary marker (anchor, flag, etc.)
in the center of the plot.
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B.3 Trimble Data File Naming Conventions

Files must be named according to the following convention:

Filename begins with the letter D, followed by the two digit number for the domain, followed by an
underscore: e.g. D01_
1. Add the four letter site ID followed by an underscore: e.g. D01_HARV_
2. Add the value denoting  Morton Order plot number followed by an underscore: e.g.

D01_HARV_1_, D01_HARV_1234020_
3. Add a letter to indicate the plot type followed by an underscore: e.g. D01_HARV_1_T_. Plot

type letters are:

 “T” to indicate a “Tower” Plot.
 “H” to indicate a “PHenology” Plot.
 “R” to indicate a “DistRibuted Base” Plot.
 “K” to indicate a “TicK” Plot.
 “M” to indicate a “Mammal” Grid.
 “B” to indicate a “Bird” Grid.
 “Q” to indicate a “MosQuito” Point.

4. If the plot is accepted the letters “GPS” are added to indicate file contains GPS data: e.g.
D01_HARV_1_T_GPS

Each time a plot is visited to collect GPS points a new file must be created. Follow the same naming
convention outlined above and add V # to the end of the file name. E.g. D01_BART_199_R_GPS_V4 if it
is your fourth time collecting GPS points at a plot.



Title: TOS Protocol and Procedure: Plot Establishment Date: 1/29/2016

NEON Doc. #:  NEON.DOC.001025 Author: E. Azuaje Revision: E

 2016 NEON Inc. All rights reserved.

Page 32 of 99

B.4 Metadata collection

Metadata collected with the GPS includes information about plot acceptance, vegetation type,
and other plot characteristics. Use the appropriate GPS data dictionary and plot ID labeling
(Section B.3). Metadata only needs to be collected once per plot.

To collect metadata use the following instructions:

a. Make sure the file used to hike to the plot has been Closed; if it hasn’t, go to the
MDD > Data and click Done.

b. When establishing plots, create a new data file for each unique plot. Go to MDD > Data, and
then go to the SDD menu and select New (T).

c. Keep the settings on File type (Rover) and Location (Default); Click on the File Name field
and choose an appropriate name. Refer to the ‘Data File Naming Guidelines’ (SOP B.3) of
this protocol for naming convention.

d. In Dictionary Name choose the GPS data dictionary that is appropriate for the given plot
and task.

e. Click Create.
f. Change antennae height to 2.000 m
g. Select Type as antenna model 2 and click OK (Do not set up the antenna at this point).
h. Open the appropriate GPS data dictionary based on the plot type you are currently in. Make

sure the receiver is active by going to the MDD>Setup; if the satellite icon is not visible: click
on the GNSS box which should be in upper right side of the screen, if the receiver is NOT
active you will see a satellite icon to the right of the MDD menu. If the receiver is already
active the following message should appear:

Are you sure you want to disconnect from GNSS receiver? Click on NO to
maintain the receiver active

All GPS data dictionaries will contain a set of features; you will need to go through all of
them.

i. Go back to the MDD>Data screen; once the new file is created open the metadata feature.
The following includes all fields across GPS data dictionaries reflected in the metadata
feature. All or a subset of these questions will be in the corresponding GPS data dictionary:

 Date: Click on the drop down menu and choose the corresponding date.
 Operator Name: click on the blank space below and the keyboard should appear, write

down the initials of the two crew members.
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 Morton Order: on the list of plots find the corresponding plot Morton Order number
and record it.

 NLCD Vegetation: click on the drop down menu and select the vegetation subclass
information that has been predetermined by NLCD and vetted by remote sensing
validation specialists.

 Site Vegetation: after a team analysis of the canopy percent cover, determine the
existing vegetation NLCD category

 Percent Cover: NLCD Percent Cover: i.e. 55 deciduous forest 45 evergreen forests.
o Make sure that the sum of the percentages add to 100%. Account for the highest

strata only (i.e. if there is an evergreen, deciduous upper canopy and a shrub
lower canopy, only account for the higher stratum for your percent cover—see
section B.2).

 Plot Accepted: if the NLCD vegetation is the same as your team’s assessment of the site
vegetation then click on YES to accept the plot, otherwise select NO. When No is
selected, several fields will recede from view, at this point click Done and close the
feature.

 Tree Cover: assess % cover based on bird’s eye view, select from the drop down.
 Saplings and shrubs cover: assess % cover based on bird’s eye view, select from the

drop down. For example, if the entire understory of a plot is shrubs but 50% of the plot
is covered by tree cover than the sapling and shrubs cover will be 50%.

 Herbaceous cover: assess % cover based on bird’s eye view, select from the drop
down.

 Slope: standing at the centroid, select the steepest slope to any of the following point
IDs: 49, 50, 51, 40, 42, 31, 32, 33. Use the rangefinder RD[19] to measure the slope
(percent).
 If the steepest slope point does not have a line of sight, choose the next location

that has a line of sight and is the closest to the steepest slope
 If there isn’t a line of sight to any of the point IDs targeted, find a line of sight that

brings you the closest to any of the previously mentioned point IDs; for example, a
line of sight between the centroid and 5 meters towards point ID 32.

 Slope Azimuth: this is the azimuth of the slope inclination previously made, use
rangefinder, RD[19].
o With Rangefinder still at low end of slope and reflector at the high end, change

measurement mode to AZ.
o Measure azimuth (degrees)
 If the slope is 0 the azimuth is not required.

 Comments: add any pertinent comments, for example ‘plot has several fallen tree
trunks.’ If there are potential obstructions that can affect GPS measurements make note
of azimuth and description of obstruction object.
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 Photos (camera icon): When prompted use the Trimble to take a photo towards the
plot centroid or for the phenology transect clockwise towards the next point on the
transect.  Be sure that photos are clear and portray the landscape only (i.e. no
technicians or backpacks).

j. Click Done to store data. Close the feature but NOT the file. A message should appear: “No
positions recorded. Do you want to store this feature now?” click Yes. If the data file is
accidentally closed follow instructions below.

How to Access an Existing Closed Data File

1. Go to MDD>Data and SDD>Existing files
2. Look for the desired existing file
3. Click on the file
4. Click Open on the lower left of the screen
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B.5 Rejected sampling plots

In all cases where a plot is rejected, record the rationale in the corresponding pre-loaded Data
Dictionary. Do not record spatial location for rejected plots. After recording metadata, move on to the
next plot location in sequence based on the Morton Order plot list. If the rejection of plots is so high
that it is not possible to establish the desired number of plots at a given site, contact FSU to provide
additional plot locations.

A selected plot may be rejected by the field crew if:

 Plot location is in a creek (wider than 10m), is too wet (see Appendix C), or presents other
geographical features that prevent sampling as specified in the associated TOS protocol(s).

 The Distributed Plot conditions do not match the NLCD vegetation classification. Note that NLCD
vegetation does not apply to Tower Plots or Phenology Plots.

 Field conditions are deemed unsafe by the field crew.
 Logistical reasons as determined by Field Operations staff; make sure the reasoning is outlined

in the comments field of the plot’s metadata.
 Tick plots may be rejected if more than 50% the plot perimeter  (i.e., 80m of the 160m

perimeter) is not amenable for tick sampling using the dragging or flagging method(s) (or both).
For example, sections of the perimeter that run through dense patches of briars likely cannot be
sampled by either method.

To record rejected plots follow these steps:

1. Make sure the file used to hike to the plot has been Closed; if it hasn’t go to the MDD > Data
and click Done.

2. Go to MDD > Data, and then go to the SDD menu and select New (T). -Use data naming
conventions (see SOP B.3) -and add the corresponding data dictionary,

3. Click Create.
4. Keep the settings on File type (Rover) and Location (Default); Click on the File Name field,

choose an appropriate name and data dictionary. e.g. D10_RMNP_1095_R_GPS.
5. Change antennae height to 1.000 m
6. Keep Type as GeoXH 6000 Internal and click OK, this will set the unit for hiking.
7. Answer all relevant questions in the GPS metadata feature (see section B.7, step Error!

Reference source not found. in this SOP for metadata fields). Once metadata are completed,
close feature.

8. Close data file; a message will appear: No positions recorded. Do you want to store this feature
now? Tap on Yes

9. Close data file; a message will appear: Close this file. Are you sure? Tap Yes.
10. And select next location following the Morton Order.
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B.6 Accepted sampling plots

Each plot will be saved under one data file during each visit. Once a file is created and named,
this file will not be closed until all points within the plot are measured (i.e. centroids and all
corner and cardinal points). Alternatively, staff could collect centroids for all plots first and then
during another instance delineate and collect the remaining points in a new file.  In this instance
the second .ssf file created will be labeled DXX_Sitecode_MOrder_plot type letter_GPS_V2.

1. Determine plot centroid/origin

If a plot centroid/origin falls on a location where it is not feasible to place a permanent marker
(e.g. a rocky outcrop), the field crew may shift the centroid to avoid an obstacle provided that
the direction of the shift is selected to minimize the deviation from the provided point (i.e. the
closest suitable location), within the specifications below.

Maximum distance of shifts by plot type:
 Distributed Base and Tower Base Plots can be shifted ≤ 3 meters (10% of the randomly

generated RRQRR cell).
 Phenology Plots cannot be shifted
 Mammal and Bird Grids can be shifted 50m and 150m respectively but new locations must

be approved by FSU staff due to additional buffers.
 Tick Plots can be shifted 15m but new locations must be approved by FSU staff due to

additional buffers.
 Mosquito Points can be shifted up to 10m.

Record compass direction, distance of shift, and rationale in the comments section of the data
dictionary.

B.7 Shifting and offsetting point locations

Shift: used to describe how much a marker can be moved from the desired point so that it can be placed
in the ground and coordinates collected at that shifted location.

Offset: used to describe placing of a marker at some recorded distance and direction from the desired
point; the high resolution coordinates are collected at the original point, not at the offset. The azimuth
and direction to the marked offset from the desired point must be recorded in the comment section of
the metadata. Also record this information in a place that will be available to staff when they re-visit the
plot.

Centroid points
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In the event that a plot centroid must be shifted, record the compass direction (azimuth from True
North) and distance of the shift, and the rationale for the shift in the metadata; then proceed to collect
high resolution GPS point data for the new location. Build out the rest of the plot with the new centroid
as a starting point.  If the plot origin is shifted up to 3 meters and a marker still cannot be placed, you
can keep the 3 meter shift and offset the marker up to 4 meters. If the offset is not enough to negotiate
around an obstacle, reject the plot, record the rationale for rejection, and select the next available
RRQRR generated contingency plot. Shifts and offsets can be used separately or in tandem depending on
site conditions.

Points at corners and cardinal directions

If an obstacle prohibits placement (e.g. there is a rock or tree) of a corner or cardinal marker, shift the
plot marker to a better location that is ≤ 0.5 m from the target location, record the rationale for the shift
in the metadata comments field, and record high resolution GPS data for the new location.  If a plot
marker cannot be placed ≤ 0.5 m of the target location proceed to offset the marker up to 4 meters;

It is acceptable to increase this 4 m offset distance threshold, however, if there are more than 5 plots
with an offset between 4 - 10 m or if at least 1 plot offset is more than 10 m, establish the offset and
contact FSU.

If the offset is not enough to negotiate around an obstacle, reject the plot, record the rationale for
rejection, and select the next available RRQRR generated contingency plot.
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SOP C Plot Delineation and Marking

The following procedure contains instructions followed by a bracketed number [#] that refers to the
pointID. Plot pointID numbering is available in Appendix C and delineation schematic in Appendix F.  We
recommend using the diagrams provided in appendices previously outlined while conducting plot
delineation.

BEFORE GETTING STARTED

 Check compass and Laser Rangefinder declination. Make sure the compass and rangefinder
have their declination set appropriately for the geographic location. Declination changes
through time so must be looked up annually for a given location. An incorrect declination will
result in shifted plots that will need to be re-delineated.
o Magnetic declination adjustment values are available at

http://www.ngdc.noaa.gov/geomagmodels/Declination.jsp
 Calibrate Rangefinder internal compass against compass. Ensure that the internal compass of

the Rangefinder has been properly calibrated by checking it against a standard mirror-site
compass in more than one direction.
o If the internal compass of the Rangefinder is not accurate, follow the calibration steps listed

in the ‘Configuring the rangefinder’ topic in RD[19].
o When checking compass calibration, take care that no metal objects are within 18 inches of

the compass or the Rangefinder– i.e. plot markers, watches, etc.
o The magnetic environment around certain buildings will completely prevent accurate

compass calibration in the Rangefinder.
 General Rules

o Measurements: The goal is to create plots of constant area when viewed from the air. Use
tape measure to delineate the plot unless site conditions make using the tape impractical
(e.g. steep slope, dense understory). If using tape measure is not possible, use the
rangefinder to delineate the plot. Use the rangefinder in slopes over 20%. When establishing
a plot where the slope of the ground is greater than 20%, measuring a distance of 10 m
along this slope with a tape will yield a horizontal line that measures less than 10 m from the
air. The same can be true if the tape has to go around large trees or over/below brush, see
obstruction methods in Appendix H.).
 Gullies and hills will, if large enough, require use of the rangefinder in order to meet this

requirement.
o Verification: when using the tape measure or rangefinder to delineate, use the rangefinder

to verify measurements. If only the rangefinder is used additional verifications can be made
by measuring from different angles/locations.
 It is required that verification measurements are within ±1 degree for the azimuth and

±0.3 meters for the distance. For example, if the instrument is verifying a horizontal
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N

[41][40] [42]

[50]

[32]

10 m
distance measured previously with the tape of 10.0 m, the rangefinder values for
verification should be between 9.7 and 10.3 meters to accept the verification.

 Plot delineation reminders:

o Always make sure the internal compass of the rangefinder is properly calibrated and
declination is properly set before beginning.

o Measure in increments of 10m or less.  Greater distance results in more errors for the tape
and rangefinder

o Always keep metal objects (including flags, chaining pins, cell phones, watches, jewelry
etc.) at least 2 feet away from the rangefinder when using the internal compass.

o If you do use a sighting compass abide by the following rules to ensure accuracy:
o Check to ensure the adjustable declination dial is set correctly.
o Hold the compass at arms-length and keep all metal objects away.
o Make sure the compass is held level to allow free movement of the magnetic

needle.
o Align the line in the mirror with the center of the needle while sighting your target.
o Carefully align both sides and the points of the needle with the guides below it.

Bring the Log Sheets (Appendix A) and fill them out once a plot has been delineated.

Although plots are a variety of sizes, all follow a combination of the following four delineation
workflows.  Tower Base Plots, Distributed Base Plots, and Tick Plots must all be delineated.  Phenology
Plots, Bird Girds, Mammal Grids, and Mosquito Points all involve using pre-loaded points in the Trimble
to place markers on the ground. This delineation process is outlined based on a two person crew:

 Person 1 holds the rangefinder and measures angles and distances and
 Person 2 holds the reflector.

Both crew members should have tapes, a handful of flags and
chaining pins. The numbers in brackets below refer to the pointIDs,
see appendix H for more information.

1. Establishing Cardinal Positions- 10m
a. Person 1, stand at the centroid with the Rangefinder and tape

anchored at centroid [41]
b. Person 2, take a compass bearing North (360/0°) and walk

unspooling tape to 10m [50]
c. Person 2, turn toward centroid, hold up reflector (away from

face) directly above tape at 10m for Person 1 Figure 3. Plot Delineation step 1
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N

[50]

[41] [42][40]

[32]

[59]

[39] [43]

[23]

20 m
1) Person 1, shoot azimuth and distance to reflector, fine tune Person 2 to the targeted

azimuth position (e.g. 180°), then verify measurement including the instrument error of
±1 degree.

2) Person 2, place a flag at the 10m N point [50]
d. Spool the tape to the centroid and complete repeat steps a-c for the remaining cardinal

directions: South [32] 180°, East [42] 90°, West [40] 270°.

2. Establishing Cardinal Positions- 20m
a. Person 1, stand at the centroid with the rangefinder and

tape anchored at centroid.
b. Person 2, take a compass bearing North (360/0°) and

walk unspooling tape to 10 meters [50]
c. Person 2, turn toward centroid, hold up reflector  (away

from face) directly above tape at 10m for Person 1
1) Person 1, shoot azimuth and distance to reflector,

fine tune Person 2 position
2) Person 2 place a flag at the 10m N point [50],

d. Continue 10m N to establish the 20m N point [59]

1) Person 1, stand at point [50] with the Rangefinder
and tape still anchored at the centroid [41]

2) Person 2, take a compass bearing North (360/0°) and walk unspooling tape to 20m [59]
3) Person 2, turn toward point [50], hold up reflector (away from face) directly above tape

at 20m for Person 1
4) Person 1, shoot azimuth and distance to reflector, fine tune Person 2 position
5) Person 2 place a flag at the 20m N point [59]

e. Spool the tape to the centroid and complete repeat steps a-d for the remaining cardinal
directions at both 10m and 20m : South [32] & [23] 180°, East [42] & [43] 90°, West [40] &
[39] 270°.

Figure 4. Plot Delineation step 2
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N

[50]

[41] [42][40]

[32]

[59]

[39] [43]

[23]

20 m[57] [61]

[25][21]

3. Establishing 20m by 20m corners
a. Establish North 20m x 20m plot corners (Appendix D and

Appendix F)
1) Person 1 and Person 2 each anchor a tape at East

[42] and West [40] respectively with a chaining pin.
2) From points [42] and [40], each person walks north

(estimate visually) 10m
3) Place chaining pins at the NE and NW corners [51] &

[49], wrap tapes around pins
4) Turn 90 degrees toward the center line [50] (meet in

the middle)
5) Anchor tape at 20m
6) Adjust corners [51 & 49] so that both sides of the tape are taut and the pins are placed

precisely at 10m
7) Once the tape is properly placed, mark corners [51 & 49].

b. Verify north layout of 20m x 20m plot
1) Person 1 stand at NW corner [49], Person 2 move to center [41]

a) Person 1 measure horizontal distance between the NW plot corner and the
centroid. Diagonal should measure 14.14 ± 0.3 meters.

c. Repeat at NE corner [51]
d. Spool tapes
e. Establish south 20m x 20m plot corners (Appendix F)

1) Facing south from points [42] and [40], follow step 1 above to establish SE [33] and SW
[31] corners.

f. Verify south layout of 20m x 20m plot
1) To verify southern layout, follow step 2 above to verify SE [33] and SW [31] corners.

4. Establishing 40m by 40m corners
(Appendix D and Appendix F). The remainder of the plot may

be completed relying on the tapes, only using the
Rangefinder to verify diagonal distance.
a. Anchor 2 tapes to NW corner [49]
b. Walk one tape 10m North [58], verify with the Range

Finder shoot azimuth (360˚) and 10m distance.
c. Place chaining pin on tape at the 10m.
d. Walk the other tape from NW corner [49] to the West

[48] 10m, verify with the Rangefinder shoot azimuth
(270˚) and 10m distance.

e. Place chaining pin on tape at the 10m.

N

[41][40] [42]

[50]

[32]

[49]

[31] [33]

[51]

10 m

Figure 5. Plot Delineation Step 3

Figure 6. Plot Delineation Step 4
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f. Wrap both tapes around 90 degrees, walk toward Northwest most corner [57]
g. Clamp both tapes at 20m intersecting the tapes at Northwest corner [57]
h. To verify layout, stand at corner [57] and shoot the Rangefinder HD back from corner [49];

the distance should = 14.14m
i. Adjust if needed
j. Flag point
k. Repeat steps to establish remaining points:

1) [51], [60] & [52] [61]
2) [33], [34] & [24] [25]
3) [31], [30] & [22] [21]

C.1 Tower Plots

Tower plot dimensions depend on vegetation type and will be listed on the site datasheet (see Table 5).

20m by 20m Tower Plot

1. Follow: Establishing Cardinal Positions- 10m (Step 1)
2. Follow: Establishing 20m by 20m corners (Step 3)
3. Leave markers and collect GPS points at [41], [49], [51], [31], [33].  See SOP B.6 for guidance on

offsetting markers.
4. Use the GPS to take photos facing toward center from points [49], [51], [31], [33].
5. Fill out log sheet (Appendix A)

20m by 20m Tower Plot with 40m corners for Soil Sampling

1. Follow: Establishing Cardinal Positions- 10m (Step 1)
2. Follow: Establishing 20m by 20m corners (Step 3)
3. Follow:  Establishing 40m by 40m corners (Step 4)
4. Leave markers and collect GPS points at [41], [49], [51], [31], [33], [57], [61], [21], [25].  See

SOP B.7 for guidance on offsetting markers.
5. Use the Trimble GPS to take photos facing toward center from points [49], [51], [31], [33].
6. Fill out log sheet (Appendix A)
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40m by 40m Tower Plots

1. Follow: Establishing Cardinal Positions- 20m (Step 2)
2. Follow: Establishing 20m by 20m corners (Step 3)

 Suggestion: Flags may be left at all 20x20m corners within 40m tower plots (where sites
permit), until tower plots with plant diversity sampling are accepted.

3. Follow:  Establishing 40m by 40m corners (Step 4)
4. Leave markers and collect GPS points at [41], [57], [59], [61], [43], [25], [23], [21], [29].  See

SOP B.7 for guidance on offsetting markers.
5. Use the Trimble GPS to take photos facing toward center from points [57], [61], [21], [25].
6. Fill out log sheet (Appendix A)

40m by 40m Tower Plots with 20m corners for Plant Diversity Sampling

1. Follow: Establishing Cardinal Positions- 20m (Step 2)
2. Follow: Establishing 20m by 20m corners (Step 3)
3. Follow:  Establishing 40m by 40m corners (Step 4)
4. Leave markers and collect GPS points at [41], [49], [51], [31], [33], [57], [59], [61], [43], [25],

[23], [21], [29].  See SOP B.7 for guidance on offsetting markers.
5. Use the GPS to take photos facing toward center from points [57], [61], [21], [25].
6. Fill out log sheet (Appendix A)

C.2 Tower Phenology Plot

Located within the tower airshed (RD[09]). See workflow sheet in Appendix C.

1. Primary Phenology Plot: 8 points every 100 meters around square transect.
a. Navigate to preloaded points with GPS receiver.
b. Place primary markers at the SW and NE points, the remaining points require secondary

markers.
c. Collect GPS points (refer to SOP D)
d. Use the GPS to take photos in a clockwise direction at all points
e. Marker type and labeling instructions located in Appendix C. See SOP B.7 for guidance on

offsetting markers.
f. Fill out log sheet (Appendix A)

2. Secondary Phenology Plot: line contains three points. Not applicable for all sites (refer to
tower data sheet in FOPS folder).

a. Navigate to preloaded points. Place primary marker at SW corner, remaining points require
secondary markers.

b. Collect GPS points (refer to SOP D)
c. Use the GPS to photos in a clockwise direction at all points
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d. If possible, place temporary flags as needed along transect to visually guide phenology
sampling efforts. For more details, refer to RD[09].

e. Marker type and labeling instructions located in Appendix C. See SOP B.7 for guidance on
offsetting markers.

f. Fill out log sheet (Appendix A)

C.3 Distributed Plots

Distributed Base Plot

1. Follow: Establishing Cardinal Positions- 20m (Step 2)
2. Follow: Establishing 20m by 20m corners (Step 3)
3. Follow Establishing 40m by 40m corners (Step 4)
4. Leave markers and collect GPS points at [41], [49], [51], [33], [31], [61], [25], [21], [57].  See

SOP B.7 for guidance on offsetting markers.
5. Use the GPS to take photos facing toward center from points [49], [51], [31], [33].
6. Fill out log sheet (Appendix A)

Distributed Tick Plots

Once at the plot verify that at least 50% of the plot perimeter (i.e., 80m of the 160m perimeter) is
amenable for tick sampling using the dragging or flagging method(s) (or both).  For example, sections of
the perimeter that run through dense patches of briars likely cannot be sampled by either method.
Additional information can be found in RD[06].

1. Follow: Establishing Cardinal Positions- 20m (Step 2)
2. Follow: Establishing 20m by 20m corners (Step 3)
3. Follow:  Establishing 40m by 40m corners (Step 4)
4. Leave markers and collect GPS points at [41], [57], [61], [25], [21].  See SOP B.7 for guidance on

offsetting markers.
5. Fill out log sheet (Appendix A)
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Figure 7. Plot layout and marker positions for 40 m by 40m Distributed
Base Plots

Distributed Mammal Grid

See workflow in Appendix C.

1. Locate the desired plot centroid with GPS reciever, using pre-loaded waypoints and/or data
files.

2. Mark the plot centroid. See SOP B.7 for guidance on offsetting markers.
3. Locate the plot corner with the GPS receiver, using pre-loaded waypoints and/or data files.

See SOP B.7 for guidance on offsetting markers.
4. Mark plot corner
5. Repeat steps 3-4 for remaining corners.
6. Set up grid before sampling as outlined in Small Mammal protocol.
7. Fill out log sheet (Appendix A)
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Distributed Bird Grid

See workflow in Appendix C.

1. Locate the desired plot centroid with GPS receiver, using pre-loaded waypoints and/or data
files.

2. Mark the plot origin, if the latter is not yet available use a temporary marker. See SOP B.7 for
guidance on offsetting markers.

3. Collect GPS point
4. Bird Grid preloaded points will be provided for use when sampling.
5. Fill out log sheet (Appendix A)

Distributed Mosquito Point

See Workflow in Appendix C.

1. Locate the point with GPS receiver, using pre-loaded waypoints and/or data files.
2. Validate the point

a. Point must be at least 5m from a road and a maximum distance of 45 m.
b. Shift the point within 10m in any direction if needed to find an acceptable hanging structure

and/or increase distance from the road. For more details, refer to RD[05]
c. Validate the vegetation within a 40m by 40m box around the point following the canopy

cover assessment of SOP B. Exclude the road during this assessment, for example if 30% of
the 40 by 40 m plot is road, exclude this 30% and assess the plot based on the
remaining 70%.

d. Fill out the data dictionary
3. If accepted mark the point with a primary marker, use a temporary marker if primary marker is

not yet available.
4. Collect the GPS point
5. Fill out log sheet (Appendix A)
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SOP D Collect GPS coordinates

After delineating a plot, GPS coordinate collection follows. To collect highly accurate coordinates, set up
surveyor style standing GPS system (Figure 8):

1. Monopole set up:
a. Set up monopole directly on top of the point to be measured
b. Add bipod legs to ensure stability.

2. Connect the antenna and GPS:
a. Connect cable to the antenna.
b. Screw antenna to the top of the monopole.
c. Connect the other end of the antenna cable to the GPS unit; connector is located in the

upper right side of the unit.
d. Open the monopole clamp and attach it to the monopole.
e. Open the GPS clamp and attach it to the GPS unit.
f. Attach the GPS clamp to the quick release mount in the monopole clamp.
g. Make sure the system remains stable.

Figure 8. GeoXH 6000 set up for high accuracy
data collection.
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Table 6. Points to be logged by FOPS (also see workflow for each plot type in Appendix C).

Plot_Type Sub_Type Module Provided by FSU
GPS points collected

by FOPS for Post
Processing

Total
Points

Distributed Base Base Centroid
Centroid, 4 corners of
20m plot, 4 DSA
corners (40m)

9

Distributed Collocated Mammal Centroid, corners Centroid 1

Distributed Collocated Bird Centroid, 9 pt grid
(includes centroid) Centroid 1

Distributed Collocated Mosquitoes Centroid Centroid 1

Distributed Collocated Ticks Centroid, 4
Corners

Centroid and 4
Corners

5

Tower Type A Tower-40m by
40m Centroid

Centroid, 4 outer
corners, 4 cardinal
points

9

Tower Type A
Tower- 40m by
40m with plant
diversity

Centroid

Centroid, 4 outer
corners, 4 inner
corners, 4 cardinal
points

13

Tower Type A Tower-20m by
20m Centroid Centroid, 4 corners 5

Tower Type A
Tower- 20m by
20m with DSA
corners

Centroid
Centroid, 4 inner
corners, 4 outer
corners

9

Tower Type B Phenology 1H 8 pts on transect 8 points along
transect 8

Tower Type B Phenology 2H 3 pts 3 pts 3
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3. Acquire GPS location
a. Begin the collection of the first point within the plot:

1) Make sure that the Antenna Height is at 2 m, and the Type refers to the Antenna Model.
Keep setting on “measure to bottom of receiver”; then click OK on “confirm antenna
height” pop-up.

2) Open the first feature of the current file (generally centroid point or other origin point is
the first)
To ensure High-Accuracy Logging

Make sure your values are:
 Position Dilution of Precision (PDOP) is ≤ 6.
 The Signal to Noise Ratio (SNR) should be ≥ 4.
 Number of satellites used ≥4.

These measurements are located on the bottom right of the MDD > skyplot in
the TerraSync software on the Trimble unit.

3) Allow the GPS to log positions (note the logging symbol in the upper right side of the
screen). Depending on the canopy cover choose the appropriate action:

 Open field or minimal canopy cover: record GPS data for at least 120 logs using the
accuracy-based logging feature.
o If the data collection of each point takes over 20 minutes, disable logging

feature (see Box 1 below) and collect the 120 logs regardless of accuracy. Once
you are back at the domain office please contact FSU and provide the list of
plots with this issue.

 Semi-open and closed canopy: record GPS data for at least 300 logs using the
accuracy-based logging feature.
o If the data collection of each point takes between 5 and 10 minutes, disable the

logging feature (see Box 1) and collect the 300 logs regardless of accuracy. Once
you are back at the domain office please contact FSU and provide the list of
plots with this issue.

Use your judgment in regards to exactly how long to wait at each point
(always a minimum of 5 minutes). Create your judgment by assessing
potential permanent obstructions like canopy cover, boulders,
mountains etc., and based on any preceding results from post
processed data received from FSU (when available).

 For all canopy conditions:
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o Verify that carrier lock and a minimum estimated accuracy of 0.5 m is
maintained for the duration of the logging. If accuracy drops check that the
skyplot information is following high accuracy standards. To view carrier lock
scroll to Status in the upper left drop down and the scroll to Receiver in the
lower left drop down menu.

o Following the completion of the first day of collection under closed canopy or
semi-open canopy conditions, notify HQ to verify that the accuracy
requirements are being met. Note: it takes 24-48 hours to post-process data.
After the post-processing accuracy check, you may be required to log more data
to meet accuracy; this depends upon plot conditions.

This feature is already enabled if you completed the GPS Setup in Appendix B.

4. Tap Done to store data. Close the feature but NOT the data file.
5. The following screen should return to the display all features that a required to be completed

for the plot at work.
a. There are several scenarios that could follow. Select the appropriate one:

 If you are at the center point, once this first point is collected and the feature is closed
move the monopole to next feature.

Or

 If a picture follows the work flow, you can take the picture while the GPS is attached to
the monopole. Make sure pictures are always taken facing the center of the plot. To
take a picture open the photo feature, tap on the photo icon to the right of the blank
box. To take the picture tap on the physical camera button located towards the bottom
center of the GPS underneath the screen. Once a photo is taken tap OK/Done.

Or

 Once the last point in the plot is collected Close the file and Save all changes. Collect all
equipment and hike to the next plot.
 Optional: To quickly verify that all required points have been collected, before

closing the file:
o Use the MDD to view the Map.
o Zoom to the area where your plot is located.
o Visually confirm that all features have been collected (each logged feature will

be displayed as an “X” on the map)
o Photo icons will only be displayed if logs were taken while the photo feature is

open, which will not always be the case
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Box 1. Disable Logging Feature

1. Go to MDD > Setup
2. Click on Logging Settings
3. Under Logging Settings click on the wrench to the right of the screen.
4. Scroll down and in the Use Accuracy-based Logging click No
5. Click Done for the two following windows and,
6. To go back to the data collection go to MDD>Data + SDD>Existing File.

By disabling this feature, the GPS will collect data of any accuracy.  For
information about setting up the accuracy based logging feature see Appendix
B, step 4.
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SOP E Data Entry and Verification

As a best practice, field data collected on paper datasheets should be digitally transcribed and
transferred to the shared folder for post-processing by FSU staff as soon as possible following plot
establishment. Ideally this will occur daily at sites where internet access is available. However, given
logistical constraints, the maximum timeline for entering data is within 14 days of collection. See RD[04]
for complete instructions regarding manual data transcription.

Once back from the field, make sure to:

 Transfer data from GPS handheld to computer (see section SOP E.1).
 Update all fields in the FOPS drive for:

o XX_X_TOS_Plots_Datasheet (e.g. 05_C_TOS_Plots_Datasheet). The naming convention and
format of this document are subject to change.

 If it is the first day of collection under a closed or open canopy forest, through e-mail, notify FSU
that there is data available for post processing.

E.1 Transferring data from GPS handheld to PC

1. Open Pathfinder Office software
2. Open the previously created project (created in step A.5)
3. Pathfinder does not save previously set coordinate systems, make sure to update the

coordinate system when transferring and verifying data, see SOP A.4 for details.
4. Connect the Trimble to the computer with the USB cable, and power on the unit.
5. The Windows Mobile Device Center (Win7 or Vista) should pop-up displaying a connection of

the device to Windows. Select “Connect without setting up my device.”
6. Within Pathfinder Office, use the Data Transfer utility to transfer the .ssf file to the Trimble:

a. Go to Utilities > Data Transfer… and in the window that opens, click the “Receive” tab and
then click Add… and select Data File from the list and click Open.

b. After selecting all data files relevant to all the new plots recorded, click Transfer All.
7. The .ssf files will be transferred automatically. Make sure all files are transferred to the shared

folder. FSU staff will post process the data files.

If certain points don’t meet the accuracy requirements, the corresponding points will have to be
re-measured.

8. Once data have been transferred, disconnect GPS from the computer.
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E.2 Data Verification

Once the data is transferred complete the following quality checks:

1. Make sure that the data file is correctly named, see SOP B.3. To view filenames go to the folder
where files were downloaded.

If the filename is incorrect, make sure that the name is changed in the GPS unit before
transferring the data to the computer. This ensures that the original, backup, and photo files all follow
the same naming convention.

a. Turn on the GPS unit
b. Open the Terra Sync Software
c. Once in Terra Sync, tap on the MDD (Main Drop Down)   menu located to the upper left side

of the screen and select Data.
d. Tap on the SDD (Sub Drop Down) menu located beneath the MDD and select Manager.
e. Below the SDD there should be a box with the list of existing data files, select the file to be

renamed.
f. Once the file is selected, tap on the options menu located parallel to the SDD in the upper

right side of the screen and select the Rename option.
g. The screen will display the file in question highlighted
h. Edit the datafile name
i. Once the rename is complete, tap outside of the filename highlighted area and this should

establish the new name of the file.
j. Once the datafile name is modified, transfer the file to the computer through the Pathfinder

transfer tool (see SOP E.1 for instructions)
k. Make sure that the incorrectly named files are deleted from the shared folder.

2. Make sure the spatial location of the point ID is accurate, for example: point ID 41 should be in
the center of the plot. To do this spatial check open the .ssf file in pathfinder office. To view the
spatial location go to the main pane of Pathfinder and click on View > click on Map. To view the
pointID in the file go to the main pane and click on Data > then click on Feature Properties.

If the point ID is incorrect make sure an e-mail is sent to FSU staff with both the incorrect
pointID and the intended pointID.

3. Send your FSU point person an e-mail to notify them about the added data ready for post
processing.

4. Update the worksheet daily (Table 5 in folder “Site_Information_&_Datasheet”).  See SOP A,
section A.8 for more information.
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E.3 Post-hoc mission analysis: Working for higher accuracy in challenging locations

Once the collected GPS data are sent to FSU, they will be post processed and assessed to determine if
points meet the accuracy standards. Field technicians will recollect any data that require re-
measurement. If re-measurement is required the mission planning can be a useful tool to make sure
that measurements will be collected at the best time of the day. Please complete the following steps for
mission planning when re-measurement occurs:

1. Go to http://www.trimble.com/GNSSPlanningOnline/#/Settings
2. To begin, click on the Setting link located in the upper left side of the window:

a. Add the latitude and longitude of one of the plots within the site to visit. Look in (RD [50])
for the latitude and longitude.

b. If the challenging areas are located close to obstructions like mountains, cliffs, or valleys use
the Obstructions tool to define the open sky area available (Figure 9). Make sure the
azimuth where the obstruction occurs is acquired. For example if there are mountains
within sight located at 95˚azimuth and 20˚ elevation:
1) Start by clicking on the blue circumference on the area around 95˚ where the

obstruction occurs. The blue circumference (represents a clear sky view) will allow the
modification of the view. Modifying the blue circumference to align with the actual sky
view available at a particular location of measurement will allow for a better assessment
of satellite availability.

Figure 9. The Obstructions tool within the Trimble Mission Planning web-based software
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2) After clicking on the line, several nodes should appear. There are two ways to apply the
azimuth and elevation to the central node:

 To the right center of the screen there should be three items representing the three
nodes, with specs on the azimuth and elevation. Click on the pencil icon in the
second item (should represent the central node) and type the azimuth and
elevation, press Enter, the obstruction curtain should be recorded.

Or

 Drag the center node to 95˚. Once the node is in the right place, use the same
center node and drag it inward, to a window should appear to the right and the
second item should reflect the azimuth and elevation of the moving target. Make
sure that the node ends up at 95˚ azimuth and 20˚ elevation. Don’t worry about the
outer nodes unless the width of the obstruction is significantly different than the
one shown on the circumference (Figure 10).

Figure 10. Adding an obstruction observed in the field within the Trimble Mission Planning software.

3) Once the desirable obstruction curtain is created click Apply and an updated satellite
histogram should be created.

c. Select the field Day
d. Select the starting time or Visible Interval and the time span in hours (generally a 6 or 12

hour span).
e. Select the appropriate Time Zone.
f. Click Apply
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3. Click on the Satellite Library
a. Click on the GPS and the GLONASS satellite libraries; unclick the rest of the satellite libraries.

4. Click on the Number of Satellites

This histogram will display the number of satellites (GPS and GLONASS) available on the day and
times previously set up in the settings window. The higher the number of satellites available, the
better the accuracy will be. This graph will allow field workers to know when the best times to
establish challenging plots may or may not be.

If there is a time in the day where satellite availability is poor, take this time to hike or do
activities other than collecting coordinates.
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SOP F Re-visiting GPS locations

F.1 Re-measuring GPS locations

If a point does not meet the required accuracy the first time around, the following steps will be used
either separately or in combination during subsequent re-measurements.  If applicable, a list of points
that have to be re-measured can be found on the second tab in the site-specific datasheet.  In most
cases FOPs will be asked to attempt re-measurement up to 4 times.

1. Wait until leaf off canopy

 If the point that needs to be collected is under deciduous leaf canopy the best solution is to
wait until the leaves drop and there is no longer any canopy cover.

2. Double or Triple the amount logs. In some cases this could be as many as 800 to 1000 logs per
high-accuracy point.

3. Utilize mission planning

 Even one or two additional satellites can make a huge different in reaching accuracy.

4. Utilize the carrier time technique.

This method utilizes open canopy areas for satellite communication before collecting logs in the
closed canopy.  Staff will either need two GPS units (one for logging, one for navigating) or be
able to re-locate the re-measurement point from an open canopy location without the use of a
GPS unit.

 In open canopy make a new file, click create, confirm the antenna height, and choose
point generic.

 Without logging points wait until you have at least two minutes of carrier lock.  To view
carrier lock  scroll to Status in the upper left drop down and the scroll to Receiver in the
lower left drop down menu.

o Two minutes of carrier time might take longer than two minutes to acquire
 Once you reach two minutes, hike to the point that will be re-measured without closing

the file you just created.
 At the point log the appropriate number of logs and pause the logging.
 Without clicking “done” or closing the file return to the open canopy area and wait until

two minutes of carrier time is obtained.
 Close the file.
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F.2 Lost Plot Markers

If markers cannot be located on subsequent visits to the plot after establishment has occurred
used the following steps to re-mark the plots.

1. Use the established .imp file corresponding to the site and plot type to find the
previously created location. This file is created after plot establishment has occurred
and will be located in a site specific folder.

a. When remarking this point, make sure that the Current Estimated accuracy
(CEA) is 50 cm or less.

i. The CEA is generally indicated on the upper right area of the Trimble
unit (this may differ depending on the terrasync and Trimble GPS unit
version)

b. If a CEA of 50cm or less cannot be achieved then follow the delineation steps in
SOP C to re-create the point location.

2. Place a new marker in the ground.
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SOP G Sample Shipment

This protocol generates no samples for shipment
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SOP H Plot Monumentation

Monumentation requirements are expected to vary from the standard monuments described in this SOP
at many sites and/or NLCD subtypes. In these cases, FOPS personnel should confirm the alternative
monuments meet science requirements with FSU personnel via NEON’s problem tracking application
(e.g. JIRA). Sites in different domains will also have differing requirements for the length of monument
rod needed for permanent installations, usually determined by the depth of the frost line or unique
substrates, which will need to be determined by domain personnel in conjunction with FSU or other
NEON staff scientists.

H.1 Permanent Marker Installation

1. If permanent monuments are not installed as part of plot establishment, begin by navigating to
target plot and corner using a map, GPS, compass, and/or tape measures as needed. Refer to
the Appendix A for instructions on which plot corners require permanent monuments. If
temporary plot markers are present, use a pry bar to remove them (Fig. 11).

Figure 11. Removing prexxisting plot markers with a pry bar

2. Assemble the initial monument assembly by threading a driving point below a rod and the
driving adapter above the same rod section using the supplied threaded connection pins. Pliers
can be used to ensure a tight connection between the different sections. Place the monument
assembly with the driving point down into the hole left by the temporary plot marker (Fig. 12).
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At plots without a preexisting temporary plot marker, lightly tap the monument assembly a few
inches into the ground using the sledgehammer as a hand hammer (i.e. grip the sledge hammer
very close to the head).

3. Continue to drive the monument into the ground using the post driver. This is a deceptively
hazardous action requiring  cautious attention to several factors:

a. Occasionally the rod assembly sections may slightly separate while driving the
monument into the ground as the connections tend to move a little counterclockwise
during each hit (Fig. 12). Because damage can occur to a rod section or threaded
connection pin if a gap forms between the monument assembly sections, frequently
pause driving the monument assembly into the ground (approximately every 10-20
strikes) to check for and tighten any loose connections.

Figure 12. Do not allow the monument assembly sections to become separated while striking

b. Do not lift the post driver too high during the striking motion as this may allow the
bottom of the post driver to rise above the top of the monument assembly. This
situation is dangerous as the worker could miss the monument on the down stroke of
the striking motion and potentially hit their leg with the post driver or hit their hand
against the top of the monument assembly (Fig. 13). If the worker can see scored line
about 1 inch below the driving adapter (Fig. 12) at any point during the striking motion
they are probably raising the post driver too high.
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Figure 13. Do not lift the post diver above the top of the rod during the striking motion as the worker could injure their leg or
hand

c. Adjust your body position as needed from a standing to a kneeling stance as the top of
the monument is driven closer to the ground. Operating the post driver above your
body reduces control of the driver, while operating the post driver below your body may
allow the driver to strike the worker in the head.

4. When the monument has been driven far enough into the ground so that A) the post driver
almost hits the ground at the bottom of the striking motion or B) the worker is making the
striking motion at an uncomfortable height/angle and the required monument rod length has
not been reached, unthread the driving adapter from the top of the monument, thread another
monument rod section onto the top of the monument assembly in the ground, and thread the
driving adapter onto the top of the new monument rod section. Repeat step 3 and 4 until the
required monument rod length has been reached.

5. When the monument has been driven far enough into the ground so the post driver almost hits
the ground at the bottom of the striking motion and the final monument rod section needed to
reach the required depth has already been attached, finish driving the monument assembly
close to the final height by repeating step 4 using a spare 2’ monument rod section threaded
above the final monument section. Repeat step 3 until the top of the final monument rod
section is a few inches above ground level, at which point the driving adapter and spare
monument rod section are removed.

6. Place the respective monument cap on top of the final rod section. Use a sledgehammer to seat
the monument cap squarely on the final monument rod section and drive the final monument
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assembly to the final desired position (Fig. 14). Ensure the cap is secure after work has been
performed.

a. Monument caps cannot be ordered until plot acceptance is done and the unique plot
IDS created.   Plot IDS are created by FSU staff after the final list of accepted plots is
available.

Figure 14. Use a sledgehammer to seat the cap and drive the rod to the desired position

H.2 Cutting a Monument Stake

Occasionally a monument is driven to refusal (i.e. the bottom has reached an impenetrable barrier)
before reaching the site specific preferred or minimum length, which leaves a length of rod still above
ground and  must be cut off or removed.

1. If the minimum monument length has been reached, use a hand or power saw to remove any
extraneous monument rod.

a. Use a marker to make a mark at the desired final height of the monument rod.
b. Pierce the center of a paper plate and push the plate down the monument rod through

this hole so the plate is resting on the ground. This plate will serve as a containment
area for any metal shavings generated during the cutting process. Properly dispose of
the shavings after work has been completed (i.e. at the support facility).

c. Slowly and carefully saw horizontally through the monument at the height mark, being
cautious near the end of the cut to maintain control of the saw and prevent large burrs
on the rod.
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d. Place the respective monument cap on top of the final rod section. Use a sledgehammer
to seat the monument cap squarely on the final monument rod section and drive the
final monument assembly to the final desired position (Fig. 14).
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APPENDIX A LOG SHEETS

A.1 Distributed Base Plot Log Sheet

.
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A.2 Tick Plot Log Sheet
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A.3 Small Mammal Grid Log Sheet
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A.4 Bird Grid Log Sheet
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A.5 Mosquito Point Log Sheet
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A.6 Tower Plot
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A.7 Phenology Tower Plot Log Sheet
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A.8 20 x 20 m Tower Plot with Destructive Sampling Area Log Sheet
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A.9 80 x 80 m Tower Plot
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A.10 Mission Planning and Assignment Sheet
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APPENDIX B GPS RECEIVER SETUP

B.1 GeoXH 6000 & Terra Sync version 5.11

Figure 15. GPS receiver Geo XH 6000

1. Turn GPS receiver on by pushing the green power button below the screen. Once the unit is on,
in the screen, look for the Windows start icon (      ) in the lower-left side of the screen (Figure ).

2. Initialize the Terra Sync software located in the Start menu of the High Resolution GPS unit.
3. Adjusting GPS Time

On the first day of work at a site, make sure that the GPS unit Time Zone, Date and Time are
appropriate to the location where the measurements will be collected. See instructions below:

 Click on the time stamp at the top right of the screen. A pop up bar will appear
underneath.

 Click on the clock icon
 Adjust the time Zone, Date, and Time
 Click on the box for Sync to current time zone
 Click OK

4. Setup Menu

Logging Settings

In the upper-left corner at the MDD menu select Setup, tap on Logging Settings:

a. In Accuracy Settings tap on the wrench ( ) icon and make sure the Accuracy Values For
Display/Logging settings are:
1) Horizontal
2) Postprocessed
3) Postprocessing Base Distance:

 Obtain this information from RD 20- the NEON Configured Site List.
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4) Base Data: select GPS+GLONASS
5) Use Accuracy-based Logging: select Yes
6) Apply Accuracy-based Logging To: Point Features and Vertices
7) Required Accuracy: 50cm
8) Tap Done located in the lower left area of the screen

b. Point/Vertex Auto-pause Count: tap on None
c. Antenna Height, tap on the wrench ( )and  modify the following to:

1) Antenna Height: 1m
2) Confirm: Per File
3) Type: select the appropriate antenna, when setting up the unit for hiking, select the

internal antenna.
4) Part Number:
5) Measure Height to: bottom of receiver
6) Tap Done

d. Allow Position Update: tap on Confirm
e. Confirm End Feature: select No
f. Filename Prefix:

1) Refer to SOP B.3 (Trimble Data File Naming Conventions) to determine the what the
first nine characters of the filenames for the site where you will be working, which will
take the form of D##_SITE_ . Since the first part of the filename will not change, this
may be set this as your prefix to save time in the field.
a) For example, Domain 02 working at SCBI would use the prefix D02_SCBI_ .

2) Optional: Placeholder text can be used to indicate the required file name format (see
SOP B.3). Items beyond the four-letter site code can then be replaced with plot-specific
text in the field.
a) For example: D02_SCBI_Morton#_plotType_GPS_V# .

g. Waypoint Filename Prefix: W
h. Between Feature Logging:

1) Style: Time
2) Interval: off

i. Tap Done at the bottom left side of the screen.
GNSS Settings

Tap on GNSS Settings:
a. GNSS Receiver Port: COM3
b. Check on the box for Use Smart Settings
c. NMEA Output: OFF
d. Tap Done located in the lower left area of the screen
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Real-time Settings
Tap on Real-time Settings:

a. Choice 1: tap on Use Uncorrected GNSS
b. Tap Done

Coordinate System
Tap on Coordinate System:

Select the coordinate system used for all shapefiles and imagery uploaded to the unit for a
specific site.

a) System: obtain this information from (RD [20])- the NEON Configured Site List
b) Zone: obtain this information from (RD [20])- the NEON Configured Site List
c) Datum: obtain this information from (RD [20])- the NEON Configured Site List
d) Altitude Reference: Mean Sea Level (MSL)
e) Altitude Units: Meters
f) Display USNG: OFF
g) Coordinate Units: Meters
h) Coordinate order: East/North
i) Click Done located in the lower left area of the screen

Units

Tap on Units:
a. Distance Units: Meters
b. Area Units: Square Meters
c. Velocity Units: Kilometers per hour
d. Angle Units: Degrees
e. Lat/Long Format: DD.ddd˚
f. Offset Format: Horizontal/Vertical
g. North Reference: Magnetic Declination
h. Magnetic Declination: Make sure that the declination is set on auto.

 Declination changes with time and space; as long as the GPS is in auto, it will update it
automatically. Positive declination values are East, negative values are West. To verify
the correct auto declination is set, obtain the current declination values for your
location from http://www.ngdc.noaa.gov/geomag-web/#declination .

External Sensors

5. Tap on External Sensors: uncheck all sensor check boxes. This concludes GPS settings. Unit can
be shut down or brought to standby mode.
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APPENDIX C CRITERIA FOR PLOT ESTABLISHMENT IN WET LOCATIONS
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APPENDIX D PLOT ESTABLISHMENT WORKFLOWS

D.1 Overall field steps
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Type: Tower Subtype:
Base Plot

Locate Centroid

Mark Centroid

Delineate a 40 X 40 m plot

Forest vegetation plot Grassland/agricultural vegetation

Delineate a 20 X 20 m plot

Collect  high resolution GPS
coordinates for all points

Primary Marker label PlotID (e.g. CPER_001) and PointID (e.g. 41)
Secondary Marker label all markers with corresponding PointID numbers, see
above (e.g. 57)
Photos taken towards plot centroid

41

23

5957

39

21 25

43

61

41

51

3331

49

Complete validation and fill out metadata

20m

10m

D.2 Tower Plot Workflow
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Type: Tower
Subtype: Base Plot

Only for a subset of tower plots that will measure: Biogeochemistry, Microbe, and Plant
Diversity.  See the XX_XXXX_TOS_Plot_Datasheet column “subtype Specification”

Locate Centroid

Mark Centroid

Collect  high resolution GPS
coordinates for all points

Primary Marker label PlotID (e.g. CPER_001) and PointID (e.g. 41)
Secondary Marker label all markers with corresponding PointID numbers, see
above (e.g. 57)
Photos taken towards plot centroid

Complete validation and  fill out metadata

41

23

5957

39

21 25

43

61

20m

10m

51

3331

49

Delineate a 40 X 40 m tower plot
And

20 x 20 m plot

Forest vegetation plot Grassland/agricultural vegetation

Delineate a 20 X 20 m plot
And

40 x 40 m corners

41

57

21 25

61

20m

10m

51

3331

49

D.3 Tower Plot, Subset that includes Soil and Plant Diversity Sampling
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Type: Tower
Subtype:  Phenology Plot

100m

Use preloaded data to locate and mark
all points

Final plot is
200 x 200 m

Collect  High resolution GPS
coordinates for all points

Primary Marker label  PlotID (e.g. CPER_001) and PointID (SW, NE)
Secondary Marker label all markers with corresponding PointID  cardinal
directions, see above (e.g. NW)
Take photos towards next point on transect in  a clockwise  direction

NE

E

SESSW

W

NW N

Fill out metadata

D.4 Tower, Primary Phenology Plot Workflow



Title: TOS Protocol and Procedure: Plot Establishment Date: 1/29/2016

NEON Doc. #:  NEON.DOC.001025 Author: E. Azuaje Revision: E

 2016 NEON Inc. All rights reserved.

Page 84 of 99

D.5 Tower, Secondary Phenology Plot Workflow

Type: Tower
Subtype: Phenology Plot

Secondary Plot if applicable

100m

Use preloaded data to locate and
mark all points

Final transect is
200 m

Primary Marker label PlotID (e.g. CPER_001) and PointID (SW)
Secondary Marker label all markers with  corresponding PointID cardinal
directions, see above (e.g. S)
Take photos towards next point on transect in clockwise direction.

Collect  GPS coordinates for all points

SESSW

Fill out metadata
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D.6 Distributed, Distributed Base Plot Workflow

Type: Distributed
Subtype: Base Plot

Locate Centroid

Mark Centroid

Delineate Plot
Inner plot 20 x 20 m
Outer plot 40 x 40 m

Collect  GPS coordinates for all points

Primary Marker label PlotID  (e.g. CPER_001) and PointID  (e.g. 41)
Secondary Marker label all markers with corresponding PointID numbers, see above
(e.g. 57)
Photos taken towards the centroid

41

51

61

21

31 33

25

49

57

Complete validation and  fill out metadata

20m
10m
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D.7 Distributed, Tick Plot Workflow
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D.8 Distributed, Small Mammal Grid Workflow
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D.9 Distributed, Bird Grid Workflow
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D.10 Distributed, Mosquito Point Workflow
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APPENDIX E NLCD VEGETATION CLASSIFICATION DESCRIPTION

Class/Value Classification Description
Water areas of open water or permanent ice/snow cover.

11 Open Water - areas of open water, generally with less than 25% cover of vegetation or soil.

12 Perennial Ice/Snow - areas characterized by a perennial cover of ice and/or snow, generally greater
than 25% of total cover.

Developed areas characterized by a high percentage (30% or greater) of constructed materials (e.g. asphalt,
concrete, buildings, etc.).

21 Developed, Open Space - areas with a mixture of some constructed materials, but mostly vegetation
in the form of lawn grasses. Impervious surfaces account for less than 20% of total cover. These areas
most commonly include large-lot single-family housing units, parks, golf courses, and vegetation
planted in developed settings for recreation, erosion control, or aesthetic purposes.

22 Developed, Low Intensity - areas with a mixture of constructed materials and vegetation. Impervious
surfaces account for 20% to 49% percent of total cover. These areas most commonly include single-
family housing units.

23 Developed, Medium Intensity – areas with a mixture of constructed materials and vegetation.
Impervious surfaces account for 50% to 79% of the total cover. These areas most commonly include
single-family housing units.

24 Developed High Intensity -highly developed areas where people reside or work in high numbers.
Examples include apartment complexes, row houses and commercial/industrial. Impervious surfaces
account for 80% to 100% of the total cover.

Barren areas characterized by bare rock, gravel, sand, silt, clay, or other earthen material, with little or no
"green" vegetation present regardless of its inherent ability to support life. Vegetation, if present, is
more widely spaced and scrubby than that in the green vegetated categories; lichen cover may be
extensive.

31 Barren Land (Rock/Sand/Clay) - areas of bedrock, desert pavement, scarps, talus, slides, volcanic
material, glacial debris, sand dunes, strip mines, gravel pits and other accumulations of earthen
material. Generally, vegetation accounts for less than 15% of total cover.

Forest areas characterized by tree cover (natural or semi-natural woody vegetation, generally greater than 5
meters tall); tree canopy accounts for 20% to 100% of the cover.

41 Deciduous Forest - areas dominated by trees generally greater than 5 meters tall, and greater than
20% of total vegetation cover. More than 75% of the tree species shed foliage simultaneously in
response to seasonal change.

42 Evergreen Forest - areas dominated by trees generally greater than 5 meters tall, and greater than
20% of total vegetation cover. More than 75% of the tree species maintain their leaves all year.
Canopy is never without green foliage.

43 Mixed Forest - areas dominated by trees generally greater than 5 meters tall, and greater than 20%
of total vegetation cover. Neither deciduous nor evergreen species are greater than 75% of total tree
cover.
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Class/Value Classification Description
Shrubland areas characterized by natural or semi-natural woody vegetation with aerial stems, generally less

than 5 meters tall, with individuals or clumps not touching to interlocking. Both evergreen and
deciduous species of true shrubs, young trees, and trees or shrubs that are small or stunted because
of environmental conditions are included..

51 Dwarf Scrub - Alaska only areas dominated by shrubs less than 20 centimeters tall with shrub canopy
typically greater than 20% of total vegetation. This type is often co-associated with grasses, sedges,
herbs, and non-vascular vegetation.

52 Shrub/Scrub - areas dominated by shrubs; less than 5 meters tall with shrub canopy typically greater
than 20% of total vegetation. This class includes true shrubs, young trees in an early successional
stage or trees stunted from environmental conditions.

Herbaceous areas characterized by natural or semi-natural herbaceous vegetation; herbaceous vegetation
accounts for 75% to 100% of the cover.

71 Grassland/Herbaceous - areas dominated by gramanoid or herbaceous vegetation, generally greater
than 80% of total vegetation. These areas are not subject to intensive management such as tilling,
but can be utilized for grazing.

72 Sedge/Herbaceous - Alaska only areas dominated by sedges and forbs, generally greater than 80% of
total vegetation. This type can occur with significant other grasses or other grass like plants, and
includes sedge tundra, and sedge tussock tundra.

73 Lichens - Alaska only areas dominated by fruticose or foliose lichens generally greater than 80% of
total vegetation.

74 Moss - Alaska only areas dominated by mosses, generally greater than 80% of total vegetation.

Planted/Cultivated areas characterized by herbaceous vegetation that has been planted or is intensively managed for the
production of food, feed, or fiber; or is maintained in developed settings for specific purposes.
Herbaceous vegetation accounts for 75% to 100% of the cover.

81 Pasture/Hay – areas of grasses, legumes, or grass-legume mixtures planted for livestock grazing or
the production of seed or hay crops, typically on a perennial cycle. Pasture/hay vegetation accounts
for greater than 20% of total vegetation.

82 Cultivated Crops – areas used for the production of annual crops, such as corn, soybeans, vegetables,
tobacco, and cotton, and also perennial woody crops such as orchards and vineyards. Crop
vegetation accounts for greater than 20% of total vegetation. This class also includes all land being
actively tilled.

Wetlands areas where the soil or substrate is periodically saturated with or covered with water as defined by
Cowardin et al., (1979).

90 Woody Wetlands - areas where forest or shrubland vegetation accounts for greater than 20% of
vegetative cover and the soil or substrate is periodically saturated with or covered with water.

95 Emergent Herbaceous Wetlands - Areas where perennial herbaceous vegetation accounts for
greater than 80% of vegetative cover and the soil or substrate is periodically saturated with or
covered with water.
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APPENDIX F PLOT DELINEATION LAYOUT

Use the following schematics in the field to keep track of your progress, place diagram in page protector,
and mark off points with a dry erase as you locate them. Rounded corners indicate where tape is
wrapped.

F.1 Tower Plot – 40x40 meters
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F.2 Tower Plot – 20x20 meters

Rangefinder/Compass + Tape

Primary plot marker
Secondary plot marker

14.14 m

NE 045°

Centroid

SE 135°SW 225°

NW 315°

20 m

N 360°

E 90°

S 180°

W 270°

10 m

5149 50

42

33

41

31 32

40
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APPENDIX G SCHEMATIC OF COMPLETE GRID USED TO LABEL PLOT POINTS

Figure 16. Schematic of the point ID grid
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APPENDIX H TROUBLESHOOTING

H.1 GPS

 The unit shuts down on its own:
o Click on the Power button once to check if it is on standby mode. If it were on standby it

should turn on once
o Restart the unit by pressing on the Power button and check the battery, if the battery is low,
o Replace the battery with a fully charged extra battery

 TerraSync map display is incorrect:
o Tap with the stylus on MDD>Setup, then tap on coordinate system and make sure the

coordinate system, zone, and datum are correct.
o If the map doesn’t display correctly check the .imp file coordinate system by locating

the  .txt file located in the shared folder where the .imp file is locate on the computer.
o Click on the .txt files in the corresponding folder and find the one that displays the .imp file

in use and check the output data coordinate system, zone and datum. If the coordinate
system is incorrect, the file will have to be imported again into Pathfinder with the corrected
coordinate system.

 Accidentally clicked on the camera button:
o Click OK to the bottom right of the screen.
o Click on the ‘X’ symbol to the bottom right of the screen, the next screen should be the

TerraSync working screen
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H.2 Plot Establishment Obstructions

 Large trees, rocks or over/below brush

If there are obstructions (i.e. large tree, rocks…) between Person 1 & Person 2 when using the
rangefinder to place a marker or make measurements:

o Use the Rangefinder 360R in HD mode to accurately measure 10m of horizontal distance
along the slope. Depending on the degree of slope, this could result in moving the flag to
10.5 m instead of 10 m. If this is performed along the center line, this adjustment should be
propagated through the remaining points on that line (i.e. 20.5, 30.5 etc.). Using the
Rangefinder in filter mode and shooting at a reflector can help determine where exactly to
place the flag.

o Both people can step to the side up to 3 times away from the point or use an alternative
standardized measurement to get a clear reading (Error! Reference source not found.).
Once a clear reading is acquired move back to the original point and place marker.

Figure 17. Alternative strategy when obstructions are in line of sight during plot delineation

o If low/high stature obstructions are encountered between Person 1 & person 2 when using
the tape, pull the tape up/down on both ends and measure above/below the obstruction;
make sure to use the rangefinder to verify results.
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 Plot verification obstructions
o When looking for a line of sight for verification, if the initial suggested diagonal line of sight

is obstructed, use the Pythagorean Theorem c2 = b2 + a2 to find the unobstructed
hypotenuse of a right triangle within the plot to complete the verification (Error! Reference
source not found.4). For example, if there is a line of obstruction for verification of point 49
from point 41 when delineating a 20 by 20 meter plot, there are several hypotenuse options
(Error! Reference source not found.4a) select the one that is clear of obstructions and use it
to verify point 49 (Error! Reference source not found.4b). Calculate the hypotenuse
distance with the base and the height of the right triangle; in this case using the right
triangle between points 49, 31 and 32 (Error! Reference source not found.b) the
hypotenuse “c” would be:

c2 = b2 + a2

c = √(202 + 102)
c = √(500)
c = 22.36 meters

In order to verify point 49 from point 32 the distance measured with both the tape and the
range finder should be 22.36 meters.

Figure 18. Hypotenuse option to verify plot delineation measurements;
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APPENDIX I PLOT MONUMENT INSTALLATION JSA

DESCRIPTION OF JOB TASK: As required in the TOS Protocol and Procedure for Plot
Establishment, up to two permanent monuments will be installed at all distributed and tower plots where
the site host has approved such monumentation. The permanent markers generally consist of one or more
sections of aluminum rods, a top cap stamped with information related to the point and plot, and a bottom
spike to facilitate driving the rod into the ground.

Item JOB STEP
SEQUENCE

POTENTIAL
HAZARDS

RECOMMENDED SAFE
PRACTICE

1 Travel to jobsite. Before
work begins, review
steps of this procedure
with workers. Inspect
worksite for hazards.

Improper use or
failure of
equipment can
cause serious
injury or
property
damage.
Driving,
Bees/Wasps,
Ice, Trips, etc.

Before the work starts, the crew
must be aware of the potential
hazards associated with the task.
The team must also be aware of
the intended safe procedures and
the appropriate PPE to be worn
during the operation. Journey
Management and Vehicle safety
best practices should be
followed.

2 Inspect and put on
personal protective
equipment.

Failure to
identify worn
PPE. Improper
use of PPE.

Personnel should inspect PPE
before use. It is the end user’s
responsibility to ensure PPE is
in functional condition before
beginning work.

3 Remove old temporary
markers.

Strain on back. Use crowbar to gain leverage to
reduce strain on back.

4 Build Permanent
Marker segments.

Segments could
loosen, causing
marker to bend,
leading to a
missed blow
with the T-post
driver.

Use pliers or a wrench with teeth
to tighten each segment and
driving adapter before being to
pound marker with T-post
driver.

5 Drive Permanent
Marker into the ground.

Loud noise,
blisters on hand,
crushing of
hands, strain on
back.

Ear protection must be worn by
both people on the plot. Thick,
impact gloves must be worn by
the person using the T-post
driver. DO NOT lift the T-post
driver above the scored marking
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line on the top section of the
Permanent Marker while using
the T-post driver. The second
person on the plot should be
watching the person using the T-
post driver to ensure this does
not happen. After every 6-12
blows with the T-post driver,
check the connections of the
marker segments and the driving
adapter segments and the driving
stud.

6 Attach additional
Permanent Marker
segments until needed
depth is reached.

Strain on back. Do not continue to operate the
T-post driver once the
Permanent Marker has reached
an uncomfortable position.
Attach a new segment of marker
to reduce back strain.

7 Permanent Marker may
need to be cut, if
bedrock or difficult soil
substrate is
encountered. A battery
powered reciprocating
saw or hacksaw are the
appropriate tools for
this.

Cutting off
finger, loud
noise, hot metal
shards in eyes or
on hands.

Both people on the plot must
wear safety glasses, gloves and
hearing protection. When
assembling the hand or power
saw, be sure to have parts
secured before beginning to cut
the Permanent Marker. The
second person on site should
verify this before cutting begins.
If both people are not
comfortable using the sawzall
then a hacksaw will be used
instead.

8 Install Marker Cap Strain on back,
crushing hands.

Once the Permanent Marker has
reached needed depth, remove
excess segments installed to
reduce back strain. Then install
Marker Cap with a plastic sledge
hammer


